JBoss AOP - Aspect-Oriented Framework for Java

JBoss AOP Reference Documentation

11



Table of Contents

(= =0 PSSR %
R I 1 15PN 1
L1 OVEBIVIBIV ettt ettt e oo oo ettt et e e e e e e e et tee et e eeee e e e e nntteeeeeaaeeeeaansnteseeeaaeeeeaannsnnneeeaens 1

2. IMPIEMENEING ASDECES ...vvviiiiie e e ittt e e e e s e e e e e e s s e ettt e e e e e e e e s aasatatas et eaaeessaasntsteseeaaesssasnssraeneeaaessaans 2
N R @ V= o PRSP 2

A 1 0\V/o o= Lo a1 @ o] = AU PT PP 2
2 S SROUPERSRTRRI 2

2.3 AFPECL ClBSS ..o, 3

2.4, AQVICE MEINOUS ......eeiieiiiiii et e et e e et b e e e e et e e e s anbb e e e e e nnbeeeeean 3

2.5. RESOIVING ANNOLBLIONS ......eeiiiiiieeeeiiteie ettt e e e e et e e e e e e e e e e b e e e e e annr e e e e nanrrneeeans 4

A TV = = - PP PUPRPPRPRN 4
2.6.1. ReSOIVING XML MELBOEEA .......ceeeeiiieiieeiiiiee ettt e e 4

2.6.2. AtaChing MELAOAEA .....eiiiieiiiiiiiieiee e e e e e e e e e e e et e e e e e aeeaans 4

2.7. MIXINDEFINITION ..o 5
2.8.DYNAMIC CHIOW ..o 5

3. Pointcut and TYPE EXPIrESSIONS .......ccuiiiiiiiiee e e i ettt e e e e e st e e e e e e e s s st ae e e e e ae s s s s ssabaaeeeeaeesssansraereeaens 6
0 0 T o =1 o LSRR 6

G I I/ 0= = = 1 PR SUPPPPRN 6

G I IV 1 oo = 1 = 1 SRR 6

3.4, CONSLIUCLON PEIEEIMS .....eiiiiiiiiiiiiiiiiiie ittt ettt ettt ettt et et et et et et et e e e e eeeeeeeeeeeees 7

BE. FEAPAENS ... 8

G T o1 1 (o1 SRR 9

A = o T 1 (o | @0 700 1= ] (o] o P ESSPR 10

3.8. POINICUL REFEIENCES ... eeiiieiiie ettt e e e e et e e e e e e s e st e e e e e e e s s snntaaeeeaaeeeeannnneees 11

3.9, TYPEAEf EXPIESSIONS ....uiiiiiiiii e ittt e s e e e e e e e e e e e e s e ettt e e e e e e e e s s saataaeeeaeeessananreees 11

T Y | I = 0o 1 o S PP OO P PP TPPP 12
I o | T PP PP PPPPPPPPP 12

4.2. RESOIVING XML ittt ettt e ettt e ettt e e e st e e e et e e e e e enbb e e e e e nnnneeas 12
4.2.1. Standalone XML RESOIVING .....uieiiiiiiiieee et e e e e e e e e s e enneeeeeeeens 12

4.2.2. Application Server XML RESOIVING ..ccoviieiiiiiiiiiiiie ettt 12

e G | [ 5 N 1 5 12

S o ot PSR 14
o = ¥ Lol B T T o Tl (o o 14

A 01 | < P 14

R A ©ol o1 1o 101 = o H PO PUP PP 15

I T I 3= RESR 16

4.4.3.2. EXample ConfigUIation ...........cccuvviiiieee i e e e e 16

444, ASPECE FACIOMES ...ttt e e e e e e e e e nnne s 16

T 1 011= (/= () SRR 16

G o 1 oo SRR 17

O - o SRS 17

4.8, POIMECUL ..eeeeeietteee e ettt e ettt ettt e ettt e e ekttt e e ekttt e e st e et a2 ek et e e e an kb et e e e nbb e e e e e nsbe e e e e anbb e e e e e nnnneeas 18

e I 111 oo 8o o] o IR 18
4.9.1. INterface iNtrOTUCLIONS ......cciiiiiiiieiiiieie ettt e st e e s sbr e e e s nnnneeas 18

JBoss 1.1



JBoss AOP - Aspect-Oriented Framework for Java

4.9.2. IMIIXINIS .eeeieiieie ettt ettt e ettt e e ettt e e e h et e e e e n bt e e e e b bt e e e e b e e e e e R be e e e e nnta e e e e e nnreeas 18

V2 (O g aTe = 1 [o T 01 [H 1 o o RSSO 19

g o [0 T o USRI 19
A Y 1< o (< O PP OTP PRSPPI 20
G T 0 | 7= 1 oo o 20
O o €= o = | < 20
ST 01 =6 = - RS 20
SR 01 o = = o [0 o L= PRSP 21
O o= o= L= o TR PTP PRSP 21
S o L= = R ESTER 22
4.18.1. dECIAr€-WAIMIING ....eeeieiiuiiiee et e ettt ettt e st e e e st e e e s be et e e s st b e e e et et e e s nnbb e e e e e nnnneeas 22

o L= o = == g o S 22

A alaTo = (o L T =T 1o [ o = RO PPPRPPR 23
DL @ASDECE ..ottt ettt ettt et n et et nen et enen ettt enn et e e e s eneeens 23

5.2, @INLEICEPLOIDES .......iiiiieiiie e e e e e e e e e e e e e e e e e e e aanraaes 24
5.2.1. INtErceptor EXAMPIE ......ooiiiiiiiiie ittt e e e e 25

5.2.2. AspectFactory EXample ..., 26

SR @] = ol 41 (o101 {5 = TR 26

o3 B (2] =T o SRS 28

TSI @ g 10 o (UTox 110 o AR TR 30

CS I T (o) (1 SRR SUPRRSTRRR 31

A (e = 7= (SRR 34
5.7.1. @Prepare POJO ......ccoiuiiieiiiiiiee ittt ai e e e e et e s s e e e e e e e e e 35

SRS T (o 1Y/ 0= = RS SURRRTRR 36

R @0 = [0 T = T 37
5.10. @DYNaMICCHIOWDES .......coiiiieiiiiee ettt e e e e e et e e e e e e e e s e e e e e e e e e ennnneees 39
5.11. @ANNOtati ONINEFOAUCTIONDET .. .cevviiieiet ettt e et et e ettt r e e et et e e e e eetreeeestreeeeebrresesrneeeees 40

N A ) (=00 (< 1 o= TR 42
5.13. @DeclareError and @DeclaréWarnNing ............eeeeeeeiiiiiiiiiieeeee e e et e e e e e e eseirreree e e e e e e s eenneees 44

6. DYNAMIC AP ..ottt ettt e et e oo ettt e o4ttt e e e s bt e oo s ke e e e e e st b e e e e e bt et e e e nne e e e e e nnr e s 46
6.1. HOt DEPRIOMENL ... 46

B.2. P INSLANCE AOP ...ttt e e ettt e e e s e s s bbb et e e e e e e e e e bbb e e e e e e e e e e anrnees 46

R £ o= = 1o o PP PPPPPPPPRPPTOTPRPN 47

7. Annotation ComPIler FOr IDK L4 .....oeoiiiiii e e e e e e e e e e e e e s e s bbb e e eeaeeeaas 48
7.1 ANNOatioNS WIth IDK 142 ...ttt e e e e e e e e e e e e e e e e s et e e e eaeeeeennnnenes 48

T.2. ENUMS TN JIDK 142 oottt ettt e ettt e e e sttt e e e ettt e e e e ntt e e e e annbaeeesansneeeeans 49

7.3. Using ANnotations Within ANNOLELIONS ..........coiiiriiiiiiiiie e sene e 50

7.4. Using the Annotation Compiler ... 51

ST 115 1 o PRSP PPPEPPR 54
8.1. INStAlliNG SLANAEIONE ........eeiiiiieie et e e 54

8.2. Installing with JB0SS 4.X APPIICAION SEIVEL .....veviiiieiiiiiieee e e 54

8.3. Installing with JB0SS 3.2.6 APPliCaLION SEIVEr ......eiiiiiiiiie it 54

9. Building and Compiling ASpectized JaVa ............ccooeee i, 56
9.1, INStrUMENtAEION MOES ......coeeeeieieee e 56

0.2, ANLINLEGIAlioN ....cccoe e 56

0.3, COMMEBNG LINE ..ttt ettt e ettt e e e e bbbt e e s e bb e e e e e st b e e e e annbe e e e s nnbneeeeans 59

10. Running ASPeCtiZed APPIICEIIONS ........cciiiiiiiieiiie ettt e et e e e s e e e s s e e e e s snnneeeeaas 61
10.1. Loadtime vs. COMPIELIME ......uviiiiiiii e e e e e e e e e e e e et raaeeaeas 61
10.2. Regular JAVa APPIICALIONS .......eieiiiiieieeiiei ettt e e s st e e e s e e e e anrneeeeans 61

JBoss 1.1



JBoss AOP - Aspect-Oriented Framework for Java

10.2.1. Precompiled iNSIrUMENEAtioN ...........ccuvviieiiie e e s e e e e nnnes 61
O o = |11 1 1 RSP 63
10.2.2.1. LOBAtME IDK L4 ..ottt e e e st e e e e e e e e e e e e e nees 63

10.2.2.2. Loadtime With DK 5 ......uiiiiiiiice ettt e e e e e 64

10.3. JBOSS APPIICALION SEIVEL ... .eeieiiiiie e et e et e e e e e e e sttt e e e e e e e e s s et e e eaaeeeeaannnseeeeeeens 64
10.3.1. Packaging AOP APPLICALIONS .........cccuvriieiiie e e e e nnnnes 64
10.3.2. IBOSSA.X @NA IDK L4 ..ot e ettt e e e e e et e e e e anae e e e e nnneeeeennnaeeeean 65
10.3.3. IBOSSA.X @A IDK 5 ..ottt st e e e nnrae e e e 65
10.3.4. JBBoss Application Server 3.2.X and JDK 1.4 ......cooiiiiiiiiiiiiie it 66

11, REFIECHON @NA AOP ...ttt ettt e e e e e e ettt e e e e e e s s e babeteeeaeeeeeaanntbbeeeeeaaeeaanns 69
11.1. Force interception VIareflECtION .........cooouuiiiiiiiiiie et 69
11.2. Clean results from reflection info MEethOdS ... 71
12. JBOSSAOP IDE ...ttt et e e et et e e e r e e e e e bt e e nnbaeeeeaas 73
O I 12 | 1 5 73
2 1 01 g To PRSP 73
20 T U o - SRR 74
12.3. 1. Creat@ PrOJECE .....eeiiiiiiee ettt e e et e e e et e e s ane e e e e e nnte e e e ennraeeeean 74
A B O = (Y O = S ERRPR 75
12.3.3. Create INEEICEPILON ... . 76
12.3.4. Applying the INTErCEPLOr ......eeviiie e e e e s neeees 76
12.3.5. RUNNING ..ottt ettt e et e e et et e e e s e e e e asb e e e e e annbe e e e e nnrneeenns 77
G B ST N F VT 7= 1 o o S UERPRR 77
12.3.6.1. AQVISEA MArKErS ..oocceiiciieiiee ettt e e e s e eeeeas 77

12.3.6.2. The Advised MemBDErS VIEW .......ooiiiiiiiiiiie e 78

12.3.6.3. The ASPECt MaANAGEr VIBW .....uviiiiiiiiiee ettt 79

JBoss 1.1



Preface

Aspect-Oriented Programming (AOP) is a new paradigm that allows you to organize and layer your software ap-
plications in ways that are impossible with traditional object-oriented approaches. Aspects allow you to transpar-
ently glue functionality together so that you can have a more layered design. AOP allows you to intercept any event
in a Java program and trigger functionality based on those events. Mixins allow you to introduce multiple inherit-
ance to Java so that you can provide APIs for your aspects. Combined with JDK 5.0 annotations, it allows you to
extend the Java language with new syntax.

JBoss AOP is a 100% Pure Java aspected oriented framework usable in any programming environment or tightly
integrated with our application server.

This document is meant to be a boring reference guide. It focuses solely on syntax and APIs and worries less about
providing real world examples. Please see our "User Guide: The Case for Aspects' document for a more interesting
discussion on the use of aspects.

If you have questions, use the user forum linked on the JBoss AOP website. We also provide tracking links for
tracking bug reports and feature requests. If you are interested in the development of JBoss AOP, post a message
on the forum. If you are interested in translating this documentation into your language, contact us on the devel oper
mailing list.

Commercia development support, production support and training for JBoss AOP is available through JBoss Inc.
(see http://www.jboss.org/). JBoss AOP is a project of the JBoss Professional Open Source product suite.

In some of the example listings, what is meant to be displayed on one line does not fit inside the available page
width. These lines have been broken up. A '\' at the end of aline means that a break has been introduced to fit in the
page, with the following lines indented. So:

Let's pretend to have an extrenely \
long line that \
does not fit

This one is short

Isredly:

Let's pretend to have an extrenely long line that does not fit
This one is short

JBoss 1.1 \Y;



Terms

1.1. Overview

The section defines some basic terms that will be used throughout this guide.

Joinpoint
A joinpoint is any point in your java program. The call of a method. The execution of a constructor the access
of afield. All these are joinpoints. You could aso think of a joinpoint as a particular Java event. Where an
event is a method call, constructor call, field access etc...

Invocation
An Invocation is a JBoss AOP class that encapsulates what ajoinpiont is at runtime. It could contain informa-
tion like which method is being called, the arguments of the method, etc...

Advice
An advice is a method that is called when a particular joinpoint is executed, i.e., the behavior that is triggered
when a method is called. It could also be thought of as the code that does the interception. Another analogy is
that an advice isan "event handler”.

Pointcut
Pointcuts are AOP's expression language. Just as a regular expression matches strings, a pointcut expression
matches a particular joinpoint.

Introductions
An introduction modifies the type and structure of a Java class. It can be used to force an existing class to im-

plement an interface or to add an annotation to anything.

Aspect
An Aspect is a plain Java class that encapsulates any number of advices, pointcut definitions, mixins, or any
other JBoss AOP construct.

I nterceptor
An interceptor is an Aspect with only one advice named "invoke". It is a specific interface that you can imple-
ment if you want your code to be checked by forcing your class to implement an interface. It also will be port-
able and can be reused in other JBoss environments like EJBs and IMX MBeans.

JBoss 1.1 1



Implementing Aspects

2.1. Overview

JBoss AOP is a100% pure Java framework. All your AOP constructs are defined as pure Java classes and bound to
your application code via XML or by annotations. This sections walks through implementing aspects.

2.2. Invocation Object

Invocation abjects are the runtime encapsulation of their joinpoint. They contain runtime information of their join-
point (args, javalang.reflect.*, etc..), and they also drive the flow of aspects.

Table 2.1. Invocation classtypes

Class Description

org.jboss.aop.joinpoint.Methodinv | Method execution. Created and used when a method is intercepted.
ocation

org.jboss.aop.joinpoint.Constructor Constructor execution. Created and used when a constructor is intercep-
Invocation ted.

org.jboss.aop.joinpoint.Fieldinvoc | Field execution. Thisis an abstract base class that encapsulates field ac-
ation Cess.

org.jboss.aop.joinpoint.FieldReadl | Field read access. Extends Fieldinvocation. Created when afield is read.
nvocation

org.jboss.aop.joinpoint.FieldWritel | Field modification. Extends Fieldinvocation. Created when a field is
nvocation written to.

org.jboss.aop.joinpoint.MethodCal | Caller pointcuts. This invocation object is allocated when you are using

ledByMethod "call" pointcut expressions. This particular class encapsulates a method
that is calling another method so that you can access the caller and
callee.

org.jboss.aop.joinpoint.MethodCal | Caller pointcuts. This invocation object is allocated when you are using

ledByConstructor "call" pointcut expressions. This particular class encapsulates a con-
structor that is calling another method so that you can access the caller
and callee.

org.jboss.aop.joinpoint.Constructor | Caller pointcuts. This invocation object is allocated when you are using
CalledByMethod "call" pointcut expressions. This particular class encapsulates a method

JBoss 1.1 2
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Class Description
that is calling a constructor so that you can access the caller and callee.

org.jboss.aop.joinpoint.Constructor | Caller pointcuts. This invocation object is allocated when you are using

CalledByConstructor "call" pointcut expressions. This particular class encapsulates a con-
structor that is calling a constructor so that you can access the caller and
callee.

2.3. Aspect Class

The Aspect Classis aplain Java class that can define zero or more advices, pointcuts, and/or mixins.

public class Aspect

public Ooject trace(lnvocation invocation) throws Throwabl e {

try {
Systemout. println("Entering anything");

return invocation.invokeNext(); // proceed to next advice or actual cal

} finally {
System out . println("Leaving anything");
}

}
}

The example above is of an advice trace that traces calls to any type of joinpoint. Notice that i nvoca-
tion.invokeNext () isused to drive the advice chain. It either calls the next advice in the chain, or does the actual
method or constructor invocation.

2.4. Advice Methods

For basic interception, any method that follows the form:

bj ect et hodNane( | nvocati on obj ect) throws Throwabl e

can be an advice. The ! nvocat i on. i nvokeNext () method must be called by the advice code or no other advice will
be called, and the actual method, field, or constructor invocation will not happen.

Method names can be overloaded for different invocation types. For instance, let's say you wanted to have a differ-
ent trace advice for each invocation type. You can specify the same method name "trace" and just overload it with
the concreate invocation type.

public class Aspect

public Object trace(Mthodl nvocation invocation) throws Throwabl e {
try {
Systemout.println("Entering nmethod: " + invocation.getMethod()");
return invocation.invokeNext(); // proceed to next advice or actual cal
} finally {
System out. println("Leaving nethod: " + invocation.getMthod()");

}

public Object trace(Constructorlnvocation invocation) throws Throwabl e {

JBoss 1.1 3
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try {

Systemout.println("Entering constructor: " + invocation.getConstructor()");
return invocation.invokeNext(); // proceed to next advice or actual call

} finally {
System out . println("Leaving constructor: " + invocation.getConstructor()");

}
}
}

2.5. Resolving Annotations

JBoss AOP provides an abstraction for resolving JDK 5.0 annotations (and JDK 1.4 annotations if you use our An-
notation Compiler). In future versions of JBoss AOP, there will be a way to override annotation values on a per
thread basis, or via XML overrides, or even provide VM and cluster wide defaults for annotation values. Also if
you want to write atruly generic advice that takes the base Invocation type, you can still get the annotation value of
the method, constructor, or field you're invoking on by calling this method:

Obj ect resol veAnnot ati on(C ass annot ati on);

That's just resolving for resolving member annotations. If your aspect needs to resolve class level annotations then
this method should be called:

bj ect resol ved assAnnot ati on(Cl ass annot ati on)

2.6. Metadata

2.6.1. Resolving XML Metadata

Untyped metadata can be defined within XML files and bound to org.jboss.aop.metadata. SimpleM etaData struc-
tures. This XML data can be attached per method, field, class, and constructor. To resolve this type of metadata, the
Invocation object provides a method to abstract out where the metadata comes from.

Ooj ect get Met aDat a( Obj ect group, Object attr)

When this method is called, the invocation will look for metadata in this order:

1. Firstit looksin the Invocation's metadata ( Si npl eMet aDat a get Met aDat a() )

2. Next it looks in org.jboss. aop. net adat a. Thr eadMet aDat a. i nst ance() . ThreadMetaData allows you to
override metadata for the whole thread. The metadata is managed by a ThreadL ocal. ThreadMetaData is used
by every single invocation object at runtime.

3. Next it looks in either org.jboss.aop.Advisor.getMethodMetaData(), Advisor.getConstructorMetaData(), or
Advisor.getFieldM etaData() depending on the invocation type.

4. Nextitlooksin either Advisor.getDefaultMetaData().

2.6.2. Attaching Metadata

Y ou can attach untyped metadata to the invocation object, or even to the response. This allows advices to pass con-
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textual datato one another in the incoming invocation or outgoing response for instance if you had advices running
on aremote client that wanted to pass contextual data to server-side aspects. This method on invocation gets you
accessto aorg. j boss. aop. met adat a. Si mpl eMet aDat a instance so that you can attach or read data.

Si npl eMet aDat a get Met aDat a()

Si npl eMet aDat a has three types of metadata, AS |S, MARSHALLED, and TRANSIENT. This allows you to spe-
cify whether or not metadata is marshalled across the wire. TRANSIENT says, attached metadata should not be
sent across the wire. MARSHALLED is for classloader sensitive contextual data. AS IS doesn't care about class-
loaders. Read the Javadocs for more information.

To piggyback and read metadata on the invocation response, two methods are provided. One to attach data one to
read data.

Ohj ect get ResponseAttachnent (Obj ect key);
voi d addResponseAttachnent (Qbj ect key, Cbject val ue);

2.7. Mixin Definition

Mixins are atype of introduction in which you can do something like C++ multiple inheritance and force an exist-
ing Java class to implement a particular interface and the implementation of that particular interface is encapsul ated
into a particular class called amixin.

Mixin classes have no restrictions other than they must implement the interfaces that you are introducing.

2.8. Dynamic CFlow

Dynamic CFlows allow you to define code that will be executed that must be resolved true to trigger positive on a
cflow test on an advice binding. (See <cflow-stack> for more information). The test happens dynamicaly at
runtime and when combined with a pointcut expression allows you to do runtime checks on whether a advice bind-
ing should run or not. To implement a dynamic CHow you just have to implement the simple
org.jboss.aop.pointcut. DynamicCFlow interface. You can then use it within cflow expressions. (See XML or An-
notations)

public interface Dynam cCFl ow

{
}

bool ean shoul dExecut e(l nvocati on i nvocati on);

JBoss 1.1 5



Pointcut and Type Expressions

3.1. Wildcards

There are two types of wildcards you can use within pointcut expressions

e * |saregular wildcard that matches zero or more characters. It can be used within any type expression, field, or
method name, but not in an annotation expression

* .. Isused to specify any number of parametersin an constructor or method expression.

3.2. Type Patterns

Type patterns are defined by an annotation or by fully qualified class name. Annotation expressions are not allowed
to have wildcards within them, but class expressions are.

* org.acne. Soned ass matches that class.
* org.acne.* Will match or g. acne. Soned ass aswell asor g. acne. Soned ass. Sonel nner d ass
* @avax. ej b. Enti ty will match any class tagged as such.

e String or ject areillegal. You must specify the fully qualified name of every java class. Even those under
thej ava. | ang package.

To reference all subtypes of a certain class (or implementors of an interface), the $i nst anceof {} expression can be
used. Wildcards and annotations may also be used within $i nst anceof {} expressions.

$i nst anceof { or g. acnme. Sonel nt er f ace}
$i nst anceof { @r g. acne. SoneAnnot at i on}
$i nst anceof {org. acne. i nterfaces. *}

are all allowed.

For very complex type expressions, the Typedef construct can be used. To reference a Typedef within a class ex-
pression $t ypedef {i d} isused.

3.3. Method Patterns

JBoss 1.1 6



Pointcut and Type Expressions

public void org.acne. Soned ass->net hodNane(j ava. | ang. Stri ng)

The attributes( publ i ¢, static, private) of the method are optional. If the attribute is |eft out then any attribute
is assumed. Attributes accept the! modifier for negation.

public !static void org.acne. SonmeCl ass->*(..)

$i nst anceof {} in the class name.

voi d $i nst anceof { or g. acne. Sonel nt er f ace} - >met hodNane(j ava. | ang. Stri ng)

Annotations can be used in place of the class name. The below example matches any methodName() of a tagged
@javax.gjb.Entity class.

void @avax.ejb. Entity->net hodNane(java.l ang. String)

Annotations can be also be used in place of the method name. The below examples matches any method tagged as
@javax.gjb.Tx.

* *.>@avax.ejb. Tx(..)

In addition you can use typedefs, $i nst anceof {}, annotations and wildcards for method parameters and return
types. The following matches all methods called | oadEnt i ty that return a class annotated with @javax.gjb.Entity,
that takes a class annotated as @org.acmeAnn and any class that matches java.*. String (such as
javalang.String).

@ avax.ejb. Entity *->l oadEntity(@rg. acne. Ann, java.*. String)
Y ou can aso include an optional throws clause in the pointcut expression:

public void org.acne. Soned ass->net hodNane(j ava.l ang. String) \
throws org. acne. SomeException, java.lang. Exception

If any exceptions are present in the pointcut expression they must be present in the throws clause of the methods to
be matched.

3.4. Constructor Patterns

public org.acne. Soned ass->new(j ava. | ang. Stri ng)

Constructor expressions are made up of the fully qualified classname and the new keyword The attributes( publ i c,
static, private) of the method are optional. If the attribute is left out then any attribute is assumed. Attributes
accept the! modifier for negation.

I'public org.acne. Soned ass->new . .)

$i nst anceof {} can be used in the class hame.

$i nst anceof { or g. acnme. Sonel nt er f ace} - >new(. . )

JBoss 1.1 7
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Annotations can be used in place of the class name. The below example matches any constructor of a tagged
@javax.gjb.Entity class.

@avax.ejb. Entity->new(..)

Annotations can be also be used in place of the new keyword. The below examples matches any constructor tagged
aS @ avax. ej b. Met hodPer mi ssi on.

*->@ avax. ej b. Met hodPer mi ssi on(. .)

In addition, just as for methods you can use typedefs, $i nst anceof {}, annotations and wildcards for constructor
parameters. The following matches all constructors that take a class annotated as @org.acme.Ann and any class
that matchesj ava. *. Stri ng (such asjavalang.String).

*->new @rg. acne. Ann, java.*.String)

Y ou can also include an optional throws clause in the pointcut expression:

public void org.acnme. Soned ass- >new(j ava. | ang. String) \
throws org. acrme. SoneExcepti on, java.l ang. Exception

If any exceptions are present in the pointcut expression they must be present in the throws clause of the construct-
orsto be matched.

3.5. Field Patterns

public java.lang. String org.acne. Somed ass->fi el dnane

Constructor expressions are made up of the type, the fully qualified classname where the field resides and the
field's name. The attributes( publ i ¢, static, private) of thefield are optional. If the attribute is left out then any
attribute is assumed. Attributes accept the! modifier for negation.

I'public java.lang. String org.acne. Somed ass- >*

$i nst anceof {} can be used in the class name. The below expression matches any field of any type or subtype of
org. acne. Sorel nterface

* $i nst anceof {org. acrme. Sonel nt er f ace} - >*

Annotations can be used in place of the class name. The below example matches any field where the type class is
tagged with @ avax. ej b. Entity.

* @avax.ejb. Entity->*

Annotations can be also be used in place of the field name. The below examples matches any field tagged as
@rg.j boss. I nj ect ed.

* *->@rg.jboss. I njected
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In addition, you can use typedefs, $instanceof{}, annotations and wildcards for field types. The following
matches all fields where the type class has been tagged with @javax.ejb.Entity.

@avax.ejb. Entity *->*

3.6. Pointcuts

Pointcuts use class, field, constructor, and method expressions to specify the actual joinpoint that should be inter-
cepted/watched.

execution(method or constructor)

execution(public void Foo->method()
executi on(public Foo->new())

execution is used to specify that you want an interception to happen whenever a method or constructor is
called. The the first example of matches anytime a method is called, the second matches a constructor. System
classes cannot be used within execut i on expressions because it isimpossible to instrument them.

get (field expression) BbbbBbb

get (public int Foo->fieldnane)

get isused to specify that you want an interception to happen when a specific field is accessed for aread.
set (field expression)

get (public int Foo->fieldnane)

set isused to specify that you want an interception to happen when a specific field is accessed for awrite.
field(field expression)

field(public int Foo->fiel dnane)

fiel disused to specify that you want an interception to happen when a specific field is accessed for aread or a
write.

al |l (type expression)

al | (org. acne. Soned ass)
all (@rg.jboss.security.Perm ssion)

al | isused to specify any constructor, method or field of a particular class will be intercepted. If an annotation
is used, it matches the member's annotation, not the class's annotation.

cal | (nmethod or constructor)

cal | (public void Foo->nethod()
call (public Foo->new())
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cal | isused to specify any constructor or method that you want intercepted. It is different than execution in
that the interception happens at the caller side of things and the caller information is available within the Invoc-
ation object. cal | can be used to intercept System classes because the bytecode weaving happens within the
callers bytecode.

wi thin(type expression)

wi t hi n(or g. acre. Soned ass)
wi thi n(@rg.jboss. security. Perm ssi on)

wi t hi n matches any joinpoint (method or constructor call) within any code within a particular call.
wi t hi ncode( net hod or constructor)

wi t hi ncode(public void Foo->net hod()
wi t hi ncode( public Foo->new())

wi t hi ncode matches any joinpoint (method or constructor call) within a particular method or constructor.
has(nmet hod or constructor)

has(voi d *->@rg. j boss. security. Pernission(..))
has(*->new(j ava.l ang. String))

has is an additional requirement for matching. If ajoinpoint is matched, its class must also have a constructor
or method that matches the has expression.

hasfi el d(field expression)

hasfiel d(* *->@rg.j boss. security.Perm ssion)
hasfi el d(public java.lang.String *->*)

has is an additional requirement for matching. If a joinpoint is matched, its class must also have a field that
matches the hasf i el d expression.

3.7. Pointcut Composition

Pointcuts can be composed into boolean expressions.

e 1 logical not.

* ANDlogical and.

 Rlogicd or.

e Parathesis can be used for grouping expressions.
Here's some examples.

cal | (voi d Foo->soneMet hod()) AND withi ncode(void Bar->caller())
execution(* *->@oneAnnotation(..)) OR field(* *->@onmeAnnot ati on)
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3.8. Pointcut References

Pointcuts can be named in XML or annotation bindings (See in later chapters). They can be referenced directly
within a pointcut expression.

sone. naned. poi ntcut OR cal |l (voi d Foo- >soneMet hod())

3.9. Typedef Expressions

Sometimes, when writing pointcuts, you want to specify areally complex type they may or may not have boolean
logic associated with it. Y ou can group these complex type definitions into a JBoss AOP Typedef either in XML or
as an annotation (See later in this document). Typedef expressions can also be used within i nt r oduct i on expres-
sions. Typedef expressions can be made up of has, hasfield, and class expressions. cl ass takes afully quali-
fied class name, or an $i nst anceof {} expression.

class(org. pkg.*) OR has(* *->@x(..)) AND !cl ass(%$i nstanceof{org.foo.Bar})
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4.1. Intro

In the last sections you saw how to code aspects and how pointcut expressions are formed. This chapter putsit all
together. There are two forms of bindings for advices, mixins, and introductions. One is XML which will be the fo-
cus of this chapter. The Annotated Bindings chapter discusses how you can replace XML with JDK 5.0 annota-
tions.

4.2. Resolving XML

JBoss AOP resolves pointcut and advice bindings at runtime. So, bindings are a deployment time thing. How does
JBoss AOP find the XML filesit needs at runtime? There are a couple of ways.

4.2.1. Standalone XML Resolving

When you are running JBoss AOP outside of the application server there are afew ways that the JBoss AOP frame-
work can resolve XML files.

e jboss. aop. pat h Thisisasystem property thatisa';' (Windows) or ":' (Unix) delimited list of XML files and/or
directories. If theitemin the list isadirectory, JBoss AOP will load any xml file in those directories with the fi-
|lename suffix - aop. xn

e META-INF/j boss-aop. xni Any JAR filein your CLASSPATH that has aj boss- aop. xm filein the META- | NF/
will be loaded. JBoss AOP does a d asslLoader. get Resour ces(" META- | NF/ j boss- aop. xm ") to obtain all
thesefiles.

4.2.2. Application Server XML Resolving

When you are running JBoss AOP outside of the application server there are afew ways that the JBoss AOP frame-
work can resolve XML files. One is to place an XML file with the suffix *-aop. xni in the deploy directory. The
other way isto JAR up your classes and provide a META- | NF/ j boss- aop. xmi filein this JAR. This JAR file must
be suffixed with . aop and placed within the deploy/ directory or embedded as a nested archive.

4.3. XML DTD
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<?xm version='1.0" encodi ng=' UTF-8'" ?>

<I ELEMENT aop (interceptor]|introduction|netadata-| oader| nmetadat a|
st ack| aspect | poi nt cut | pl uggabl e- poi nt cut | bi nd|
prepare| cf | ow st ack| dynani c-cfl oW annot ati on-i ntroducti on|typedef) +>

<I ELEMENT i nt er cept or ANY>

<I ATTLI ST i nterceptor nane CDATA #| MPLI ED>

<I ATTLI ST i nterceptor class CDATA #l MPLI ED>

<I ATTLI ST interceptor factory CDATA #l MPLI ED>

<I ATTLI ST i nterceptor scope (PER_VM PER_CLASS| PER | NSTANCE| PER_JO NPO NT) "PER VM >

<! ELEMENT aspect ANY>

<I ATTLI ST aspect nane CDATA #| MPLI ED>

<I ATTLI ST aspect cl ass CDATA #l MPLI ED>

<I ATTLI ST aspect factory CDATA #l MPLI ED>

<I ATTLI ST aspect scope (PER_VM PER _CLASS| PER | NSTANCE| PER_JO NPO NT) "PER VM >

<! ELEMENT i ntroduction (mXxin*,interfaces)>

<I' ATTLI ST introduction class CDATA #l MPLI ED>

<I ATTLI ST i ntroducti on expr CDATA #l MPL| ED>
<IELEMENT mi xi n (interfaces, class, construction?)>
<I' ATTLI ST mixi n transient (true|false) "true">

<I ELEMENT i nterfaces (#PCDATA) >

<! ELEMENT cl ass (#PCDATA) >

<I ELEMENT construction (#PCDATA) >

<! ELEMENT net adat a- | oader EMPTY>
<I ATTLI ST net adat a-| oader tag CDATA #REQUI RED>
<! ATTLI ST net adat a-| oader cl ass CDATA #REQUI RED>

<I ELEMENT net adat a ANY>
<I ATTLI ST net adata tag CDATA #REQUI RED>
<I ATTLI ST net adata cl ass CDATA #REQUI RED>

<I ELEMENT stack (interceptor|interceptor-ref|stack-ref|advice)+>
<I ATTLI ST stack nanme CDATA #REQUI RED>

<! ELEMENT i nterceptor-ref EMPTY>
<I' ATTLI ST interceptor-ref name CDATA #REQU RED>

<! ELEMENT st ack-ref EMPTY>
<I ATTLI ST st ack-ref nane CDATA #REQUI RED>

<! ELEMENT advi ce EMPTY>
<I ATTLI ST advi ce nane CDATA #REQUI RED>
<I ATTLI ST advi ce aspect CDATA #REQUI RED>

<! ELEMENT poi nt cut EMPTY>
<I ATTLI ST poi nt cut nanme CDATA #REQUI RED>
<I ATTLI ST poi ntcut expr CDATA #REQUI RED>

<! ELEMENT prepare EMPTY>
<I ATTLI ST prepare expr CDATA #REQUI RED>

<! ELEMENT pl uggabl e- poi nt cut ANY>
<I ATTLI ST pl uggabl e- poi nt cut nanme CDATA #REQUI RED>
<I ATTLI ST pl uggabl e- poi ntcut cl ass CDATA #REQUI RED>

<! ELEMENT bind (interceptor|interceptor-ref|stack-ref|advice)+>
<! ATTLI ST bi nd nane CDATA #| MPLI ED>

<I ATTLI ST bi nd poi nt cut CDATA #REQUI RED>

<I ATTLI ST bi nd cfl ow CDATA #| MPLI ED>

<I ELEMENT cfl ow stack (call ed|not-call ed)+>
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<I ATTLI ST cfl ow stack nanme CDATA #REQUI RED>

<! ELEMENT cal | ed EMPTY>

<I ATTLI ST cal | ed expr CDATA #REQUI RED>

<! ELEMENT not -cal | ed EMPTY>

<I ATTLI ST not-cal |l ed expr CDATA #REQUI RED>

<! ELEMENT dynam c-cfl ow EMPTY>

<I ATTLI ST dynami c-cfl ow nane CDATA #REQUI RED>

<I ATTLI ST dynami c-cfl ow cl ass CDATA #REQUI RED>

<! ELEMENT annot ati on-i ntroduction (#PCDATA) >

<I ATTLI ST annot ati on-i ntroducti on expr CDATA #REQU RED>

<I ATTLI ST annot ati on-i ntroducti on invisible (true|fal se) #REQU RED>
<! ELEMENT typedef EMPTY>

<I ATTLI ST typedef name CDATA #REQUI RED>
<I ATTLI ST typedef expr CDATA #REQUI RED>

4.4. aspect

The <aspect > tag specifies to the AOP container to declare an aspect class. It is also used for configuring aspects
as they are created and defining the scope of the aspects instance.

4.4.1. Basic Definition

<aspect class="org.jboss. MyAspect"/ >
In abasic declaration you specify the fully qualified class name of the aspect. If you want to reference the aspect at
runtime through the AspectManager, the name of the aspect is the same name as the class name. The default Scope

of this aspect is PER_vM Another important note is that aspect instances are created on demand and NOT at deploy-
ment time.

4.4.2. Scope

<aspect cl ass="org.jboss. M\yAspect" scope="PER VM'/>

The scope attribute defines when an instance of the aspect should be created. An aspect can be created per vm, per
class, per instance, or per joinpoint.

Table4.1. Aspect instance scope

Name Description
PER_VM One and only instance of the aspect classis alocated for the entire VM.
PER_CLASS One and only instance of the aspect class is allocated for a particular

class. Thisinstance will be created if an advice of that aspect is bound to
that particular class.

JBoss 1.1 14



XML Bindings

Name Description

PER_INSTANCE An instance of an aspect will be created per advised object instance. For
instance, if a method has an advice attached to it, whenever an instance
of that advised class is allocated, there will also be one created for the

aspect.

PER_JOINPOINT An instance of an aspect will be created per joinpoint advised. If the
joinpoint is a static member (constructor, static field/method), then there
will be one instance of the aspect created per class, per joinpoint. If the
joinpoint is a regular non-static member, than an instance of the aspect
will be created per object instance, per joinpoint.

PER_CLASS JOINPOINT An instance of an aspect will be created per advised joinpoint. The as-
pect instance is shared between al instances of the class (for that join-
point).

4.4.3. Configuration

<aspect cl ass="org.jboss. SomeAspect" >
<attri bute name="Sonel nt Val ue" >55</ attri but e>
<advi sor-attri bute nanme="MAdvi sor"/>
<i nst ance-advi sor-attribute name="M/I nstanceAdvi sor"/>
<j oi npoi nt-attribute nane="My/Joi npoint"/>
</ aspect >

Aspects can be configured by default using a Java Beans style convention. The <at t ri but e> tag will delegate to a
setter method and convert the string value to the type of the setter method.

Table4.2. Supported Java Bean types

primitive types (int, float, String, etc...)

javalang.Class
javalang.Clasy[]
javalang.String[]
java.math.BigDecimal
org.w3c.dom.Document
javaio.File
java.net.InetAddress
java.net. URL

javax.management.ObjectName (if running in JBoss)

Besides types, you can also inject AOP runtime constructs into the aspect. These types of attributes are referenced
within XML under special tags. See the table below.
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Table4.3. Injecting AOP runtime constructs

<advisor-attribute> org.jboss.aop.Advisor

<instance-advisor-attribute> org.jboss.aop.InstanceAdvisor

<joinpoint-attribute> org.jboss.aop.j oinpoint.Joinpoint
4.4.3.1. Names

If there is no nane attribute defined, the name of the aspect isthe same asthecl ass or f act ory attribute value.

4.4.3.2. Example configuration

<aspect cl ass="org.jboss. SomeAspect" >
<attri bute name="Sonel nt Val ue" >55</attri but e>
<advi sor-attri bute name="MAdvi sor"/>
<i nst ance-advi sor-attribute name="M/I nstanceAdvi sor"/>
<j oi npoi nt-attribute nane="My/Joi npoint"/>
</ aspect >

The above example would would need a class implemented as follows:

public class SomeAspect {
publ i c SoneAspect () {}

public void setSonelntValue(int val) {...}

public void set MyAdvi sor (org.j boss. aop. Advi sor advisor) {...}

public void set Myl nstanceAdvi sor (org.j boss. aop. | nst anceAdvi sor advisor) {...}
public void set MyJoi npoi nt (org.jboss. aop.j oi npoi nt.Joi npoi nt joinpoin) {...}

4.4.4. Aspect Factories

<aspect name="M/Aspect" factory="org.jboss. Aspect Confi gFactory" scope="PER_CLASS">
<sone- arbi trary-xm >val ue</ sonme-arbi trary-xm >
</ aspect >

If you do not like the default Java Bean configuration for aspects, or want to delegate aspect creation to some other
container, you can plug in your own factory class by specifying the f act ory attribute rather than the cl ass attrib-
ute. Any arbitrary XML can be specified in the aspect XML declaration and it will be passed to the factory class.
Factories must implement the or g. j boss. aop. advi ce. Aspect Fact ory interface.

4.5. interceptor

<interceptor class="org.jboss. M/Interceptor" scope="PER VM'/>
<interceptor class="org.jboss. Sonel nterceptor">

<attri bute name="Sonel nt Val ue" >55</ attri but e>

<advi sor-attribute name="M/Advi sor"/>

<i nst ance-advi sor-attribute name="M/I nst anceAdvi sor"/>
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<j oi npoi nt-attribute nanme="My/Joi npoint"/>
</interceptor>
<i nterceptor name="MAspect" factory="org.jboss.|nterceptorConfigFactory" scope="PER CLASS">
<some-arbi trary-xm >val ue</ sone-arbi trary-xm >
</interceptor>

Interceptors are defined in XML the same exact way as aspects are. No difference except the tag. If there is no name
attribute defined, the name of the interceptor isthe same asthecl ass or f act or y attribute value.

4.6. bind

<bi nd poi nt cut =" executi on(voi d Foo->bar())">
<interceptor-ref nane="org.jboss. Wlnterceptor/>
<advi ce nane="trace" aspect="org.jboss. MyAspect"/>
</ bi nd>

In the above example, the Mylnterceptor interceptor and the trace method of the MyAspect class will be executed
when the Foo.bar method is invoked.

bind
bi nd tag is used to bind an advice of an aspect, or an interceptor to a specific joinpoint. The poi nt cut attribute
isrequired and at least an advice or interceptor-ref definition.

interceptor-ref
Theinterceptor-ref tag must reference an aready existing i nt er cept or XML definition. The name attribute
should be the name of the interceptor you are referencing.

advice
The advi ce tag takes anane attribute that should map to a method within the aspect class. The aspect attribute
should be the name of the aspect definition.

4.7. stack

Stacks alow you to define a predefined set of advices/interceptors that you want to reference from within a bi nd
element.

<stack nanme="stuff">
<interceptor class="Sinplelnterceptorl” scope="PER VM'/>
<advi ce name="trace" aspect="org.jboss. Traci ngAspect"/>
<i nterceptor class="Sinplelnterceptor3">
<attribute name="size">55</attri bute>
</interceptor>
</ st ack>

After defining the stack you can then reference it from within abi nd element.

<bi nd poi nt cut ="execution(* PQIO>*(..))">
<stack-ref name="stuff"/>
</ bi nd>
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4.8. pointcut

The poi nt cut tag allows you to define a pointcut expression, name it and reference it within any binding you want.
It is aso useful to publish pointcuts into your applications to that others have a clear set of named integration
points.

<poi nt cut nane="publ i cMet hods" expr="execution(public * *->*(..))
<poi nt cut nanme="stati cMet hods" expr="execution(static * *->*(..))"/>

The above define two different pointcuts. One that matches all public methods, the other that matches the execution
of all static methods. These two pointcuts can then be referenced within abi nd element.

<bi nd poi nt cut =" publ i cMet hods AND st ati cMet hods" >
<interceptor-ref nane="tracing"/>
</ bi nd>

4.9. introduction

4.9.1. Interface introductions

Thei nt r oduct i on tag alows you to force an existing Java class to implement a particular defined interface.

<i ntroduction class="org.acnme. \yd ass">
<interfaces>java.io. Serializabl e</interfaces>
</introduction>

The above declaration says that the org.acme.MyClass class will be forced to implement java.io.Serializable. The
cl ass attribute can take wildcards but not boolean expressions. If you need more complex type expressions, you
can usetheexpr attribute instead.

<i ntroduction expr="has(* *->@est(..)) OR class(org.acne.*)">
<interfaces>java.io. Serializabl e</interfaces>
</introduction>

Theexpr can be any type expression allowed in at ypedef expression

4.9.2. Mixins

When introducing an interface you can aso define a mixin class which will provide the implementation of that in-
terface.

<introduction class="org.acne. My ass" >
<m xi n>
<interfaces>
java.io. Externalizabl e
</interfaces>
<cl ass>or g. acne. Ext er nal i zabl eM xi n</ cl ass>
<const ructi on>new org. acne. Ext ernal i zabl eM xi n(t hi s) </ construction>
</ m xi n>
</introduction>
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interfaces
defines thelist of interfaces you are introduction

class
The type of the mixin class.

construction
The construction statement allows you to specify any Java code to create the mixin class. This code will be em-
bedded directly in the class you are introducing to so t hi s works in the construction statement.

4.10. annotation-introduction

Annotation introductions allow you to embed an annotation within a the class file of the class. Y ou can introduce
an annotation to a class, method, field, or constructor.

<annot ati on-introducti on expr="constructor(PQIO >new())">
@rg.j boss. conplex (ch="a', string="hello world", flt=5.5, dbl=6.6, shrt=5, |ng=6, integer=7, bool:
</ annot ati on-i ntroducti on>

The expr attribute takes method(), constructor(), class(), or field(). Within those you must define avalid expression
for that construct. The following rules must be followed for the annotation declaration:

e Any annotation, Class or Enum referenced, MUST be fully qualified.

4.11. cflow-stack

Control flow is a runtime construct. It allows you to specify pointcut parameters revolving around the call stack of
a Java program. Y ou can do stuff like, if method A calls method B calls Method C calls Method D from Construct-
or A, trigger this advice. In defining a control flow, you must first paint a picture of what the Java call stack should
look like. Thisisthe responsibility of the cflow-stack.

<cfl ow stack nane="recursive2">
<cal | ed expr="void PQIO >recursive(int)"/>
<cal | ed expr="void PQIO >recursive(int)"/>
<not-cal |l ed expr="void PQIO >recursive(int)"/>
</ cfl ow st ack>

A cfl ow stack has aname and a bunch of cal | ed and not - cal | ed elements that define individual constructor or
method calls with a Java call stack. The expr attribute must be a method or constructor expression. cal | ed states
that the expr must be in the call stack. not - cal | ed states that there should not be any more of the expression within
the stack. In the above example, the cf | ow st ack will be triggered if there are two and only two callsto there-
cur si ve method within the stack. Once the cf | ow st ack has been defined, it can then be referenced within abi nd
element through the cf | ow attribute. Boolean expressions are allowed here as well.

<bi nd poi nt cut =" executi on(voi d PQIO >recursive(int))" cflow="recursive2 AND !cfl ow2">
<interceptor class="Sinplelnterceptor"/>
</ bi nd>
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4.12. typedef

<typedef nanme="j nx" expr="class(@rg.jboss.|nk. @Bean) OR
has(* *->org. | boss.jnx. @kanagedOper ati on) OR
has(* *->org.jboss.jnx. @hanagedAttribute)"/>

t ypedef s allow you to define complex type expressions and then use then pointcut expressions. In the above ex-
ample, we're defining a class that is tagged as @Mbean, or has a method tagged as @M anagedOperaion or
@M anagedAttribute. The above typedef could then be used in a pointcut, introduction, or bind element

<poi ntcut name="stuff" expr="execution(* $typedef{jm}->*(..))"/>
<i ntroduction expr="cl ass($typedef{jnm})">

4.13. dynamic-cflow

dynani c- cf | ow allows you to define code that will be executed that must be resolved true to trigger positive on a
cflow test on an advice binding. (See Dynamic CFow for more information). The test happens dynamically at
runtime and when combined with a pointcut expression allows you to do runtime checks on whether a advice bind-
ing should run or not. Create a dynamic cflow class, then you must declare it with XML so that it can be used in
bind expressions.

<dynam c- cfl ow nanme="si npl e" cl ass="org. | boss. Si npl eDynam cCFl ow'/ >

Y ou can then use it within abi nd

<bi nd expr="execution(voi d Foo->bar())" cflow="sinple">

4.14. prepare

The pr epar e tag alows you to define a pointcut expression. Any joinpoint that matches the expression will be as-
pectized and bytecode instrumented. This allows you to hotdeploy and bind aspects at runtime as well as to work
with the per instance APl that every aspectized class has. To prepare something, just define a pointcut expression
that matches the joinpoint you want to instrument.

<prepare expr="execution(void Foo-bar())"/>

4.15. metadata

You can attach untyped metadata that is stored in or g. j boss. aop. net adat a. Si npl eMet aData st ruct ures Within
the or g. j boss. aop. Advi sor class that manages each aspectized class. The XML mapping has a section for each
type of metadata. Class, method, constructor, field, and defaults for the whole shabang. Here's an example:

<net adata tag="testdata" class="org.]jboss.test. PQIO" >
<def aul t >
<sone- dat a>def aul t val ue</ sone- dat a>
</ def aul t >
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<cl ass>
<dat a>cl ass | evel </ dat a>

</ cl ass>

<constructor expr="PQIOConstructorTest()">
<sone- dat a>enpt y</ sone- dat a>

</ constructor>

<met hod expr="void another(int, int)">
<ot her - dat a>hal f </ ot her - dat a>

</ met hod>

<field name="sonefiel d">
<ot her - dat a>f ul | </ ot her - dat a>

</field>

</ met adat a>

Any element can be defined under the class, default, method, field, and constructor tags. The name of these ele-
ments are used as attribute names in SimpleMetaData structures. Thet ag attribute is the name used to reference the
metadata within the Advisor, or Invocation lookup mechanisms.

4.16. metadata-loader

<net adat a- | oader tag="security" class="org.]jboss. aspects.security. Securityd assMet aDat aLoader"/>

If you need more complex XML mappings for untyped metadata, you can write your own metadata binding. The
tag attribute is wused to trigger the loader. The loader <class must implement the
org. j boss. aop. net adat a. Cl assMet aDat aLoader interface.

public interface Cl assMet aDat aLoader

{
publ i c C assMet aDat aBi ndi ng i nport Met aDat a( El ement el enent, String nane,
String tag, String classExpr) throws Exception
public void bind(C assAdvi sor advi sor, C assMet aDat aBi ndi ng dat a,
Ct Met hod[] nmethods, CtField[] fields, CtConstructor[] constructors) throws Exception
public void bind(C assAdvi sor advi sor, C assMet aDat aBi ndi ng dat a,
Met hod[] nmethods, Field[] fields, Constructor[] constructors) throws Exception
}

Any arbitrary XML can be in the net adat a element. The ClassMetaDataBinding.importMetaData method is re-
sponsible for parsing the element and building ClassMetaDataBinding structurs which are used in the precompiler
and runtime bind steps. Look at the SecurityClassMetaDatal oader code shown above for areal concrete example.

4.17. precedence

Precedence allows you to impose an overal relative sorting order of your interceptors and advices.

<pr ecedence>
<interceptor-ref nane="org.acne.|Interceptor"/>
<advi ce aspect="org. acne. Aspect"” nanme="advi cel"/>
<advi ce aspect="org. acne. Aspect" nane="advi ce2"/>
</ precedence>
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This says that when a joinpoint has both org. acne. I nterceptor and org. acne. Aspect . advi ce() bound to it,
org. acme. | nter cept or must always be invoked before or g. acne. Aspect . advi ce1() which must in turn be in-
voked before or g. acre. Aspect . advi ce2() . The ordering of interceptors/advices that do not appear in a preced-
ence is defined by their ordering for the individual bindings or intercerceptor stacks.

4.18. declare

Y ou can declare checks to be enforced at instrumentation time. They take a pointcut and a message. If the pointcut
is matched, the message is printed out.

4.18.1. declare-warning

<decl ar e-war ni ng expr ="cl ass($i nst anceof { Vehi cl eDAG}) \
AND ! has(public void *->save())">
Al'l Vehi cl eDAO subcl asses nmust override the save() nethod.
</ decl ar e- war ni ng>

The above declaration says that if any subclass of VehicleDAO does not implement a noargs save() method, a
warning with the supplied message should be logged. Y our application will continue to be instrumented/run (since
we are using decl ar e- war ni ng in this case).

4.18.2. declare-error

<decl are-error expr="call (* org.acne. businesslayer.*->*(..)) \
AND wi t hi n(org. acne. dat al ayer. *)">
Data | ayer cl asses should not call up to the business |ayer
</ decl are-error>

The above declaration says that if any classes in the datalayer call classes in the business layer of your application,
an error should be thrown. Instumentation/execution of your application will stop.
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JDK 5.0 has introduced a new concept called annotations. Annotations can be used as an alternative to XML for
configuring classes for AOP. For backward compatibility with JDK 1.4.2 JBoss AOP uses an annotation compiler
allowing you to create the same annotations in javadoc style comments.

The JDK 1.5 form has been used for the declarations of each annotation type shown below. For clarity both types
of annotations are shown in the usage examples contained in this chapter. A point worth mentioning is that in JDK
1.5 annotations are part of language and can thus be imported, so that just the classname can be used. In JDK 1.4.2
the annotations are not part of "Java" so fully qualified classnames are needed. To keep things short and sweet the
listings only import classes that are new for each listing.

5.1. @Aspect

To mark a class as an aspect you annotate it with the @spect annotation. Remember that a class to be used as an
aspect does not need to inherit or implement anything special, but it must have an empty constuctor and contain
one or more methods (advices) of the format:

publ i c Obj ect <any-net hod- name>(org.j boss. aop.j oi npoi nt. | nvocati on)

The declaration of or g. j boss. aop. Aspect is:

package org.j boss. aop;

i mport org.jboss. aop. advi ce. Scope;

i mport java.l ang. annot ati on. El enent Type;

i mport java.l ang. annotati on. Retenti on;

i mport java.l ang. annotati on. Ret enti onPol i cy;
i mport java.l ang. annot ati on. Target;

@rar get ({ El ement Type. TYPE}) @Ret enti on(Retenti onPol i cy. RUNTI ME)
public @nterface Aspect

{
Scope scope() default Scope. PER_ VM
}
and Scopeis:

package org.j boss. aop. advi ce;

publ i ¢ enum Scope

{
PER_VM PER _CLASS, PER | NSTANCE, PER JO NPO NT
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Seethe "XML Bindings' chapter for a description of the various scopes.

In JDK 1.5 we use the @A spect annotation as follows:

package com nypackage;

i mport org.jboss. aop. Aspect;
i mport org.jboss. aop. advi ce. Scope;
i mport org.jboss. aop.j oi npoint.I|nvocati on;

@\spect (scope = Scope. PER_ VM
public class MyAspect
{

}

publ i c Object myAdvi ce(lnvocation invocation)

AndinJDK 1.4.2:

package com nypackage;

/**
* @oAspect (scope = Scope. PER_ VM
*
/
public class MyAspect
{

publ i c Object nmyAdvi ce(lnvocation invocation)

{
}

return invocation.invokeNext ();

The name of the class (in this case com.mypackage.MyAspect) gets used as the internal name of the aspect. The
equivalent using XML configuration would be:

<a0p>
<aspect class="com nypackage. MyAspect" scope="PER_VM'/>
</ aop>

5.2. @InterceptorDef

To mark a class as an interceptor or an aspect factory you annotate it with the @ nt er cept or Def annotation. The
class must either implement the  org.|boss. aop. advi ce. I nt ercept or interfface or  the
org. j boss. aop. advi ce. Aspect Fact ory interface.

The declaration of or g. j boss. aop. I nt er cept or Def iS:

package org.j boss. aop;
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@rar get ({ El ement Type. TYPE}) @Ret enti on(Retenti onPolicy. RUNTI ME)
public @nterface Aspect
{

}

Scope scope() default Scope. PER_ VM

The same Scope enum is used as for Aspect . The following examples use the @Bind annotation, which will be de-
scribed in more detail below.

5.2.1. Interceptor Example

In JDK 1.5 we use the @ nt er cept or Def annotation to mark an Interceptor as follows:

package com nypackage;

i mport org.jboss. aop. Bi nd;
i mport org.jboss. aop. | ntercept or Def;
i mport org.jboss. aop. advi ce. I nterceptor;

@ nt er cept or Def (scope = Scope. PER_ VM
@i nd (poi ntcut="execution("* com bl ah. Test->test(..)")
public class Mylnterceptor inplenments |nterceptor

{
public Object invoke(lnvocation invocation)throws Throwabl e
{
return invocation.invokeNext();
}
}

AndinJDK 1.4.2:

package com nypackage;

/**

* @®rg.jboss.aop. I nterceptorDef (scope = org.jboss. aop. advi ce. Scope. PER_VM
* @@rg.jboss. aop. Bind (poi ntcut="execution("* com bl ah. Test->test(..)")

*/

public class Mylnterceptor inplenents |nterceptor

{
public Object invoke(lnvocation invocation)throws Throwabl e
{

return invocation.invokeNext();

}

}

The name of the class (in this case com.mypackage.Mylnterceptor) gets used as the class name of the interceptor.
The equivalent using XML configuration would be:

<aop>
<interceptor class="com nypackage. M/l nterceptor" scope="PER VM'/>
</ aop>
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5.2.2. AspectFactory Example

In JDK 1.5the @ nt r oduct i onDef annotation is used to mark an AspectFactory asfollows:

package com nypackage;

i mport org.jboss. aop. advi ce. Aspect Fact ory;

@ nt ercept or Def (scope=org.j boss. aop. advi ce. Scope. PER_ VM
@i nd (poi ntcut="execution("* com bl ah. Test->test2(..)")

public class Myl nterceptorFactory inplenments Aspect Factory

/1l mpl enented nethods left out for brevity

AndinJDK 1.4.2;

package com nypackage;

/**

* @®rg.jboss. aop. | nterceptorDef (scope=org.jboss. aop. advice. Scope. PER_VM
* @@rg.]jboss. aop. Bind (pointcut="execution("* com bl ah. Test->test2(..)")
*/

public class Myl nterceptorFactory inplenments Aspect Factory

/11 mpl enented nethods | eft out for brevity

The name of the class (in this case com.mypackage.MylnterceptorFactory) gets used as the factory name of the as-
pect factory. The equivalent using XML configuration would be:

<aop>
<interceptor factory="com nypackage. M/l nterceptorFactory" scope="PER VM'/>
</ aop>

5.3. @PointcutDef

To define a named pointcut you annotate a field within an @spect or @ nt ercept or Def annotated class with
@oi nt cut Def . @oi nt cut Def only appliesto fields and is not recognised outside @spect Or @ nt er cept or Def an-
notated classes.

The declaration of or g. j boss. aop. Poi nt cut Def iS:

package org.j boss. aop;

@rar get ({ El ement Type. FI ELD}) @Ret enti on(Ret enti onPol i cy. RUNTI ME)
public @nterface Pointcut Def

{
}

String val ue();
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@oi nt cut Def takesonly one value, avalid pointcut expression. The name of the pointcut used internally and when
yo want to referenceitis:

<nanme of @\spect/ @nterceptorDef annotated cl ass>. <nane of @oi ntcutDef annotated fiel d>

An example of an aspect class containing a named pointcut which it references from a bindng's pointcut expression
inJDK 1.5:

package com nypackage;

i mport org.jboss. aop. Poi nt cut Def ;
i mport org.jboss. aop. poi nt cut. Poi nt cut;

@\spect (scope = Scope. PER VM
public class MyAspect

{
@oi nt cut Def (" (execution("* org.bl ah. Foo- >someMet hod()) OR\
execution("* org. bl ah. Foo->ot her Met hod()))")
public static Pointcut fooMethods;
publ i c Object nyAdvice(lnvocation invocation)
{
return invocation.invokeNext();
}
}

It is worth noting that named pointcuts can be referenced in pointcut expressions outside the class they are declared
in (if the annotated fields are declared public of course!).

The same examplein JDK 1.4.2:

package com nypackage;

i mport org.jboss. aop. poi nt cut. Poi nt cut;

/**
* @®rg.jboss. aop. Aspect (scope = Scope. PER VM
*
/
public class My/Aspect
{

/**
* @rg.jboss. aop. Poi nt cut Def ("(execution("* org.bl ah. Foo->someMet hod()) \
OR execution("* org. bl ah. Foo- >ot her Met hod()))")
*/
public static Pointcut fooMethods;

publ i c Object nyAdvice(lnvocation invocation)

{
}

return invocation.invokeNext();

Using XML configuration this would be:

<aop>
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<aspect class="com nypackage. MyAspect" scope="PER VM'/>
<poi nt cut
nanme="com mypackage. MyAspect . f ooMet hods"
expr="(execution("* org. bl ah. Foo- >soneMet hod()) OR\
execution("* org. bl ah. Foo- >ot her Met hod()))"
/>
</ aop>

5.4. @Bind

To create a binding to an advice method from an aspect class, you annotate the advice method with @i nd. To cre-
ate a binding to an Interceptor or AspectFactory, you annotate the class itself with @i nd since Interceptors only
contain one advice (the i nvoke() method). The @Bind annotation will only be recognised in the situations just
mentioned.

The declaration of or g. j boss. aop. Bi nd iS:

package org.j boss. aop;

@rar get ({ El ement Type. METHOD, El enent Type. TYPE}) @Retenti on(RetentionPolicy. RUNTI ME)
public @nterface Bind
{

String pointcut();
String cflom) default ""

The @i nd annotation takes two parameters:

e poi nt cut, which is a pointcut expression resolving to the joinpoints you want to bind an aspect/interceptor to
e cfl ow, whichisoptional. If defined it must resolve to the name of a defined cflow.)
In the case of abinding to an advice in an aspect class, the internal name of the binding becomes:

<nane of the aspect class>. <the name of the advice nethod>

In the case of abinding to an | nt er cept or OF Aspect Fact ory implementation, the internal name of the binding be-
COMes:

<nanme of the Interceptor/AspectFactory inplenentation class>

An example of a binding using an advice method in an aspect classin JDK 1.5:

package com nypackage;
i mport org.jboss. aop. Bi nd;

@\spect (scope = Scope. PER_VM
public class MyAspect
{
@Poi nt cut Def (" (execution("* org. bl ah. Foo- >soneMet hod()) \
OR execution("* org. bl ah. Foo->ot her Met hod()))")
public static Pointcut fooMethods;
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@i nd (poi nt cut ="com nypackage. MyAspect . f ooMet hods")
public Object nyAdvice(lnvocation invocation)

{
}

@i nd (poi ntcut="execution("* org. bl ah. Bar->sonmeMet hod())")
public Object nyAdvice(lnvocation invocation)

{
}

return invocation.invokeNext();

return invocation.invokeNext ();

AndinJDK 1.4.2;

package com nypackage;

/**
* @®rg.jboss. aop. Aspect (scope = Scope. PER VM
=
public class MyAspect
{
/**

* @@rg.j boss. aop. Poi nt cut Def ("(execution("* org. bl ah. Foo->sonmeMet hod()) \
OR execution("* org. bl ah. Foo->ot her Met hod()))")

*/
public static Pointcut fooMethods;
/**
* @rg.jboss.aop. Bind (poi ntcut="com nypackage. MyAspect . f ooMet hods")
*/
publ i c Object myAdvi ce(lnvocation invocation)
{
return invocation.invokeNext ();
}
/**
* @®rg.jboss.aop. Bind (pointcut="execution("* org. bl ah. Bar->soneMet hod())")
“f
publ i c Obj ect otherAdvice(lnvocation invocation)
{
return invocation.invokeNext();
}

The equivaent using XML configuration would be:

<a0p>
<aspect cl ass="com nypackage. MyAspect" scope="PER VM'/>
<poi nt cut
nane="com nypackage. MyAspect . f ooMet hods"
expr="(execution("* org. bl ah. Foo- >soneMet hod()) OR\
execution("* org. bl ah. Foo->ot her Met hod()))"

/>
<bi nd poi nt cut ="com nypackage. MyAspect . f ooMet hods" >
<advi ce name="nmnyAdvi ce" aspect="com nypackage. M/Aspect ">
</ bi nd>
<bi nd poi nt cut ="execution("* org. bl ah. Bar - >someMet hod()) ">
<advi ce nanme="ot her Advi ce" aspect="com nypackage. M/Aspect ">
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</ bi nd>
</ aop>

Revisiting the examples above in the @InterceptorDef section, now that we know what @Bind means, the equival-
ent using XML configuration would be:

<aop>
<i nterceptor class="com nypackage. M/l nterceptor" scope="PER VM'/>
<interceptor factory="com nypackage. Myl nt erceptorFactory" scope="PER VM'/>

<bi nd poi nt cut ="execution("* com bl ah. Test->test2(..)">

<i nterceptor-ref name="com nypackage. Myl nterceptor"/>

</ bi nd>

<bi nd poi ntcut ="execution("* com bl ah. Test->test2(..)">
<interceptor-ref nane="com nmypackage. Myl nt er cept or Fact ory"/ >
</ bi nd>

</ aop>

5.5. @Introduction

Interface introductions can be done using the @ nt r oduct i on annotation. Only fields within a class annotated with
@\spect Or @ nt er cept or Def can be annotated with @ nt r oduct i on.

The declaration of or g. j boss. aop. I ntroducti on:

package org.j boss. aop;

@rar get ({ El ement Type. FI ELD}) @Ret enti on(Retenti onPol i cy. RUNTI ME)
public @nterface |ntroduction

{
Class target() default java.lang.d ass. cl ass;
String typeExpression() default "";
Class[] interfaces();

}

The parameters of @ nt r oduct i on are:

* target, the name of the class we want to introduce an interface to.

e typeExpression, atype expression that should resolve to one or more classes we want to introduce an interface
to.

e interfaces, anarray of theinterfaces we want to introduce
target Of t ypeExpressi on hasto be specified, but not both.

Thisishow to use @ nt r oduct i on in JDK 1.5:

package com nypackage;

i mport org.jboss. aop. | ntroduction;
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@\spect (scope = Scope. PER_ VM
public class IntroAspect

{
@ntroduction (target=com bl ah. Soned ass. cl ass, \
interfaces={java.io.Serializable.class})
public static Object pojoNolnterfaceslntro;
}

AndinJDK 1.4.2:

package com nypackage;

/*

* @rg.jboss. aop. Aspect (scope = Scope. PER VM
*/

public class IntroAspect

{
/*
* @rg.]jboss.aop. I ntroduction (target=com bl ah. Soned ass, \
interfaces={java.io. Serializable})
*/
public static Object pojoNolnterfaceslntro;

Notice the dlight difference in the JDK 1.4.2 annotation, the class values don't have the ".class" suffix.
This means make com bl ah. Soned ass. cl ass implement the j ava.io. Seri al i zabl e interface. The equivalent

configured via XML would be:

<i ntroduction class="com bl ah. Soned ass. cl ass" >
<i nterfaces>
java.io. Serializabl e
</interfaces>
</introduction>

5.6. @Mixin

Sometimes when we want to introduce/force a new class to implement an interface, that interface introduces new
methods to a class. The class needs to implement these methods to be valid. In these cases a mixin class is used.
The mixin class must implement the methods specified by the interface(s) and the main class can then implement
these methods and del egate to the mixin class.

Mixins are created using the @Mixin annotation. Only methods within a class annotated with @spect or
@ nt er cept or Def can be annotated with @ xi n. The annotated method has

e bepublic
* bestatic
« contain the logic to create the mixin class

e return an instance of the mixin class
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The declaration of or g. j boss. aop. M xi n:

package org.j boss. aop;

@rar get ({ El erent Type. METHOD} ) @Ret enti on(Ret enti onPol i cy. RUNTI ME)
public @nterface M xin

{
Class target() default java.lang.d ass. cl ass;
String typeExpression() default "";
Class[] interfaces();
bool ean i sTransient() default true;
}

The parameters of @1 xi n are:

* target, the name of the class we want to introduce an interface to.

* typeExpressi on, atype expression that should resolve to one or more classes we want to introduce an interface
to.

e interfaces, anarray of the interfaces we want to introduce, implemented by the mixin class.

* isTransient. Internally AOP makes the main class keep areference to the mixin class, and this setsif that ref-
erence should be transient or not. The default is true.
target Of t ypeExpr essi on hasto be specified, but not both.

An example aspect using @ xi n in JDK 1.5:

package com nypackage;

i mport org.jboss.aop. M xin;
i mport com nmypackage. PQIO

@\spect (scope=org.|jboss. aop. advi ce. Scope. PER_VM
public class Introducti onAspect

{
@ xin (target=com nypackage. PQJO. cl ass, interfaces={java.io.Externalizable.class})
public static Externalizabl eM xin creat eExternalizabl eM xi n(PQJO poj o) {
return new Externalizabl eM xi n(poj o) ;
}
}

Here'sthe IDK 1.4.2 version:

package com nypackage;

i mport org.jboss. aop. M xi n;
i mport com nmypackage. PQIO

/**
* @@rg.j boss. aop. Aspect (scope=org.jboss. aop. advi ce. Scope. PER_ VM
*/
public class Introducti onAspect
{
/**

* @rg.]jboss.aop. M xin (target=com nypackage. PQJO. cl ass, \
i nterfaces={java.io. Externalizabl e.cl ass})
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=
public static Externalizabl eM xin creat eExternalizabl eM xi n(PQJO poj o) {
return new Externalizabl eM xi n(poj o) ;

}

Since thisis dlightly more complex than the previous examples we have seen, the PO and Ext er nal i zabl eM xi n
classes are included here.

package com nypackage;

public class PQIO

{
}

String stuff;

package com nypackage;

i mport java.io.Externalizabl e;
i mport java.io.| OException;

i mport java.io.Qojectlnput;

i mport java.io.ObjectQutput;

public class Externalizabl eMxin inplenments Externalizable

{

PQJO poj o;
publ i c Externalizabl eM xi n(PQJO poj o)
{
this.pojo = pojo;
}

public void readExternal (Qojectlnput in) throws | OException, C assNot FoundException

{
poj o.stuff = in.readUTF();

}
public void witeExternal (CbjectCQutput out) throws | OException
{
out.witeUTF(pojo.stuff);
}

This has the same effect as the following XML configuration:

<introduction cl asss="com nypackage. PQIO'>
<m xi n transient="true">
<interfaces>
java.io. Externalizable
</interfaces>
<cl ass>com nypackage. Ext er nal i zabl eM xi n</ cl ass>
<construction>l ntroducti onAspect. creat eExt ernal i zabl eM xi n(t hi s) </ construction>
</ m xi n>
</introduction>
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5.7. @Prepare

To prepare ajoinpoint or a set of joinpoints for DynamicAOP annotate a field with @r epar e in a class anotated
with @spect or @ nt er cept or Def .

The declaration of or g. j boss. aop. Prepare iS:

package org.j boss. aop;
@rar get ({ El ement Type. FI ELD, El enent Type. TYPE}) @Ret enti on(Retenti onPolicy. RUNTI ME)

public @nterface Prepare {
String value() default

The single field val ue contains a pointcut expression matching one or more joinpoints.

To use @r epare in JDK 1.5:

package com nypackage;
i mport org.jboss. aop. Prepare;
@ nt ercept or Def (scope = Scope. PER_VM

@Bi nd (poi ntcut="execution("* com bl ah. Test->test(..)")
public class Mylnterceptor2 inplenents |nterceptor

{
@repare ("all (com bl ah. Dynani cPQIO) ")
public static Pointcut dynam cPQIQ
public Object invoke(lnvocation invocation)throws Throwabl e
{
return invocation.invokeNext ();
}
}

AndinJDK 1.4.2;

package com nypackage;

/**
* @®rg.jboss.aop. I nterceptorDef (scope = org.jboss. aop. advi ce. Scope. PER_VM
* @@rg.]jboss. aop. Bi nd (pointcut="execution("* com bl ah. Test->test(..)")

*/
public class Mylnterceptor2 inplenents |nterceptor
{
/**
* @®rg.jboss.aop. Prepare ("all (com bl ah. Dynam cPQIO ")
*/

public static Pointcut dynam cPQIQ,

public Object invoke(lnvocation invocation)throws Throwabl e

{
}

return invocation.invokeNext();
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Using XML configuration instead we would write:

<prepare expr="all (com bl ah. Dynanm cPQIO) "/ >

This simple example used an @ nt er cept or Def class for a bit of variety in the examples, and to reiterate that
@oi nt cut , @ ntroducti on, @M xi n, @r epar e, @vypedef, @CFl ow, @ynam cCFl ow and
@nnot ati onl ntroducti onDef can al be used both in @ nt er cept or Def annotated classes AND @spect annot-
ated classes. Same for @i nd, but that is a specia case as mentioned above.

5.7.1. @Prepare POJO

Y ou can aso annotate a POJO with @Prepare directly in cases where you are using Dynamic AOP, and the exact
bindings are not known at instrumentation time. In this case you annotate the class itself. Here's how it is done in
JDK 1.5:

package com nypackage;

i mport org.jboss. aop. Prepare;

@repare ("all(this)")

public class MyDynami cPQIO i npl emrents | nterceptor
{

}
al | (this) meansthesameasal | (com bl ah. MyDynani cPQIO) , but the use of al | (t hi s) isrecommended.

JDK 1.4:

package com nypackage;

i mport org.jboss. aop. Prepare;

/**

* @®rg.jboss.aop. Prepare ("all(this)")

*/

public class MyDynam cPQJO i npl ements | nterceptor
{

}
The examples just given equate to this XML

<prepare expr="all (com bl ah. MyDynam cPQIO) "/ >

To summarise, when using @Prepare within an @Interceptor or @Aspect annotated class, you annotate a field
within that class. When using @Prepare with a POJO you annotate the class itself.
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5.8. @TypeDef

To use atypedef, you annotate a field with @ypeDef in aclass anotated with @spect Or @ nt er cept or Def .

The declaration of or g. j boss. aop. TypeDef :

package org.j boss. aop;

@rar get ({ El ement Type. FI ELD}) @ret enti on(Ret enti onPol i cy. RUNTI ME)
public @nterface TypeDef {

String val ue();
}

The single val ue field takes a type expression that resolves to one or more classes. The name of the typedef used
for reference and internally is:

<nanme of @\spect/ @nterceptorDef annotated cl ass>. <nane of @ypeDef annotated fiel d>

Here's how to use it with JDK 1.5:

package com nypackage;

i mport org.jboss. aop. TypeDef;
i mport org.jboss. aop. poi nt cut. Typedef ;
@\spect (scope=org.jboss. aop. advi ce. Scope. PER_VM
public class Typedef Aspect
{
@ypebDef ("class(com bl ah. PQIO)")
public static Typedef myTypedef;

@Bi nd (poi ntcut="execution(* \
$t ypedef {com nmypackage. Typedef Aspect . nyTypedef } - >met hodW t hTypedef ())")
publ i c Object typedef Advice(lnvocation invocation) throws Throwabl e

{
}

return invocation.invokeNext();

And with JDK 1.4.2:

package com nypackage;

i mport org.jboss. aop. TypeDef;
i mport org.jboss. aop. poi nt cut. Typedef;

/**
* @rg.jboss. aop. Aspect (scope=org. | boss. aop. advi ce. Scope. PER_VM
*/
public class Typedef Aspect
{
/**
* @rg.jboss. aop. TypeDef ("class(com bl ah. PQJO)")
“f

public static Typedef nyTypedef;

/**
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* @@rg.]jboss. aop. Bind (pointcut="execution(* \
$t ypedef { com nypackage. Typedef Aspect . nyTypedef } - >met hodW t hTypedef ())")

*/

public Object typedefAdvice(lnvocation invocation) throws Throwabl e

{

return invocation.invokeNext();

}

The equivaent using XML configuration would be:

po

<a0p>
<aspect class="com nypackage. Typedef Aspect" scope="PER>VM'/ >

<t ypedef nane="com nypackage. Typedef Aspect. nyTypedef" expr="cl ass(com bl ah. PQIO) "/ >

<bi nd

nt cut ="execution(* \

$t ypedef { com nypackage. Typedef Aspect . nyTypedef } - >met hodW t hTypedef () )"
>

<advi ce nanme="t ypedef Advi ce" aspect ="com nmypackage. Typedef Aspect"/ >

</ bi nd>

</ aop>

5.9. @CFlowDef

To create a CHow stack, you annotate a field with @Fl owbef in a class anotated with @spect or
@ nt er cept or Def . The declaration of or g. j boss. aop. CFl owSt ackDef iS.
package org.j boss. aop;
@rar get ({ El ement Type. FI ELD}) @Ret enti on(Ret enti onPol i cy. RUNTI ME)
public @nterface CFl owst ackDef
CFl owDef [] cflows();
}
In turn the declaration of or g. j boss. aop. CFl owDef iS:
package org.j boss. aop;
public @nterface CFl owDef {
bool ean cal |l ed();
String expr();
}
The parameters of @rl owDef are:
e cal | ed, whether the corresponding expr should appear in the stack trace or not.
e expr, astring matching stack atrace element
The name of the CFlowStackDef used for reference and internally is:
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<nane of @Aspect/ @ nterceptorDef annotated cl ass>. <nane of @CFl owsSt ackDef annotated fiel d>

CFlowStackDef isused like thisin JDK 1.5:

package com nypackage;

i mport org.jboss. aop. CFl owSt ackDef ;
i mport org.jboss. aop. poi nt cut. CFl owst ack;

@\spect (scope=org.|jboss. aop. advi ce. Scope. PER_VM
public class CFl owAspect

{

@CFl owst ackDef (cf | ows={ @Fl owDef (expr= "voi d com bl ah. PQIO >cf | owivet hod1()", \
cal | ed=fal se), @Fl owDef (expr = "voi d com bl ah. PQIO >cf | owMvet hod2() ", \
cal l ed=true)})

public static CFl owStack cfNot1And2St ack;

@i nd (poi nt cut="execution(void com bl ah. PQIO*- >pri vMet hod())", \
cfl ow="com nypackage. CFl owAspect . cf Not 1And2St ack")

public Object cflowAdvice(lnvocation invocation) throws Throwabl e

{

return invocation.invokeNext();
}
}
Andin14.2:

package com nypackage;

i mport org.jboss. aop. poi nt cut . CFl owSt ack;

/**
* @rg.]jboss. aop. Aspect (scope=org.jboss. aop. advi ce. Scope. PER VM
*/
public class CFl owAspect
{
/**

* @rg.]jboss. aop. CFl owst ackDef (cfl ows={ @r g.j boss. aop. CFl owDef \
(expr= "void com bl ah. PQJO >cf | omvet hod1()", called=false), \
@r g. j boss. aop. CFl owDef (expr = "void com bl ah. PQIO >cf | omvet hod2()", \
cal l ed=true)})
*/
public static CFl owStack cfNot1And2St ack;

/**
* @rg.jboss.aop. Bi nd (pointcut="execution(void com bl ah. PQIO*->privMethod())", \
cf |l ow="com nypackage. CFl owAspect . cf Not 1And2St ack")
*/
public Object cflowAdvice(lnvocation invocation) throws Throwabl e

{
}

return invocation.invokeNext();

The above means the same as this XML :
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<a0p>

<cfl ow st ack nane="com nypackage. CFl owAspect . cf Not LAnd2St ack" >
<cal | ed expr="void com bl ah. PQIO >cf | omvet hod1()"/>

<not-cal |l ed expr="void com bl ah. PQIO >cf | omvet hod2() "/ >

</ cfl ow st ack>

</ aop>

5.10. @DynamicCFlowDef

To create a dynamic CFlow you annotate a class implementing or g. j boss. aop. poi nt cut . Dynani cCFl ow With
@ynani cCFl owbef . The declaration of @r g. j boss. aop. Dynani cCFl owDef iS.

package org.j boss. aop;

@rar get (El enent Type. TYPE) @Ret enti on(Ret enti onPol i cy. RUNTI ME)
public @nterface Dynam cCFl owDef

{
}

Hereis a @DynamicCFlow annotated classin JDK 1.5:

package com nypackage;

i mport org.jboss. aop. Dynam cCFl owDef ;
i mport org.]jboss. aop. poi nt cut . Dynani cCFl ow,

@ynam cCFl owDef
public class MyDynam cCFl ow i npl ements Dynam cCFl ow

{
public static bool ean execute = fal se;
publ i ¢ bool ean shoul dExecut e(l nvocati on invocati on)
{
return execute;
}
}

And the samein JDK 1.4.2:

package com nypackage;

i mport org.jboss. aop. poi nt cut . Dynani cCFl ow,

/**

* @rg.]jboss. aop. Dynam cCFl owDef

*/
public class MyDynam cCFl ow i npl ements Dynam cCFl ow
{

public static bool ean execute = fal se;

publ i ¢ bool ean shoul dExecut e(l nvocati on invocati on)

{
}

return execute,;
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The name of the @ynani cCFl owbef annotated class gets used as the name of the cflow for references.

To use the dynamic cflow we just defined in JDK 1.5:

package com nypackage;

@\spect (scope=org.jboss. aop. advi ce. Scope. PER_VM
public class CFl owAspect

{
@i nd (poi nt cut ="execution(void com bl ah. PQIO >soneMet hod() )", \
cf I ow="com nypackage. MyDynani cCFl ow")
public Object cflowAdvice(lnvocation invocation) throws Throwabl e
{
return invocation.invokeNext ();
}
}

To use the dynamic cflow we just defined in JDK 1.5:

package com nypackage;

/**
* @rg.|jboss. aop. Aspect (scope=org. | boss. aop. advi ce. Scope. PER_VM
*/
public class CFl owAspect
{
/**
* @rg.jboss. aop. Bi nd (poi nt cut ="execution(void com bl ah. PQIO- >soneMet hod())", \
cfl ow="com nypackage. M/Dynani cCFl ow")
*/
public Object cflowAdvice(lnvocation invocation) throws Throwabl e
{
return invocation.invokeNext();
}
}

5.11. @AnnotationintroductionDef

You can introduce annotations by annotating a field with the @nnot ati onl ntroducti onDef in a class anotated
with @spect or @ nt er cept or Def . The declaration of or g. j boss. aop. Annot at i onl nt r oduct i onDef IS;

package org.j boss. aop;

@arget (El ement Type. Fl ELD) @Retention(RetentionPolicy. RUNTI VE)
public @nterface Annotationlntroducti onDef

{
String expr();
bool ean i nvisible();
String annotation();
}

JBoss 1.1 40



Annotation Bindings

The parameters of @nnot ati onl nt roduct i onDef are:

e expr, pointcut matching the classes/constructors/methods/fields we want to annotate.

* invisible,if true: the annotation's retention is RetentionPolicy.CLASS,; false: RetentionPolicy. RUNTIME

* annot at i on, the annotation we want to introduce.

The listings below make use of an annotation called @om nypackage. MyAnnot at i on:

package com nypackage;
public interface MyAnnotation

{
String string();
int integer();
bool ean bool ();
}

What its parameters mean is not very important for our purpose.

The use of @nnot ati onl nt roduct i onDef in JDK 1.5:

package com nypackage;

i mport org.jboss. aop. Annot ati onl ntroducti onDef :
i mport org.jboss.aop.introduction. Annot ati onl ntroducti on;

@ | nt ercept or Def (scope=org. | boss. aop. advi ce. Scope. PER_VM
@r g. j boss. aop. Bi nd (poi ntcut="all (com bl ah. SomePQIO) ")
public class IntroducedAnnotationlnterceptor inplenments |nterceptor

{
@r g. j boss. aop. Annot ati onl ntroducti onDef \

(expr="net hod(* com bl ah. SonePQIC- >annot at i onl nt r oduct i onMet hod()) ",

i nvi si bl e=fal se, \
annot at i on=" @om nypackage. M\yAnnot ati on \
(string="hello', integer=5, bool=true)")
public static Annotationlntroduction annotati onlntroduction;

public String get Nane()

{
return "I ntroducedAnnot ati onl nterceptor”;
}
public Object invoke(lnvocation invocation) throws Throwabl e
{
return invocation.invokeNext();
}

\

Note that the reference to @om nypackage. MAnnot ati on must use the fully qualified class name, and that the

value for its string parameter uses single quotes.

The use of @nnot ati onl nt roducti onDef in JDK 1.4.2:

package com nypackage;

i mport org.jboss. aop.introduction. Annot ati onl ntroducti on;
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/**
* @®rg.jboss. aop. I nterceptorDef (scope=org.jboss. aop. advice. Scope. PER_VM
* @@rg.]jboss. aop. Bind (pointcut="all(com bl ah. SomePQIO) ")
*/

public class IntroducedAnnotationlnterceptor inplenents |nterceptor

{
/**
* @rg.j boss. aop. Annot ati onl ntroducti onDef \
(expr="net hod(* com bl ah. SonePQJO- >annot at i onl nt r oduct i onMet hod())", \
i nvi si bl e=fal se, \
annot ati on=" @om nmypackage. MyAnnot ati on \
(string="hello', integer=5, bool=true)")
*/
public static Annotationlntroduction annotationlntroducti on;
public String get Nane()
{
return "I ntroducedAnnot ati onl nterceptor”;
}
public Object invoke(lnvocation invocation) throws Throwabl e
{
return invocation.invokeNext ();
}
}

Note that the reference to only uses one'@’', and that the value for its string parameter uses single quotes.

The previous listings are the same as this XML configuration:

<annot ati on-i ntroduction

expr ="met hod(* com bl ah. SonePQJO >annot at i onl ntroduct i onMet hod())

i nvi si bl e="fal se"
>

@om nypackage. MyAnnot ati on (string="hello", integer=5, bool=true)
</ annot ati on-i ntroducti on>

5.12. @Precedence

Y ou can declare precedence by annotating a class with @r ecedence, and then annotate fields where the types are
the various Interfaces/Aspects you want to sort. You annotate fields where the type is an interceptor with
@ ecedencel nt er cept or . When the type is an aspect class, you annotate the field with @r ecedenceAdvi ce. The
definitions of org.jboss.aop.Precedence, org.jboss.aop.Precedencel nterceptor and org.jboss.aop.PrecedenceAdvice
are

package org.j boss. aop;

@rar get ({ El ement Type. TYPE}) @Ret enti on(Retenti onPolicy. RUNTI ME)
public @nterface Precedence

{
}

package org.j boss. aop;
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@rar get ({ El ement Type. FI ELD}) @Ret enti on(Retenti onPol i cy. RUNTI ME)
public @nterface Precedencel nterceptor

{
}

package org.j boss. aop;

@rar get ({ El ement Type. FI ELD}) @Ret enti on( Ret enti onPol i cy. RUNTI ME)
public @nterface PrecedenceAdvice

{
}

String val ue();

Theval ue() attribute of PrecedenceAdvi ce isthe name of the advice method to use.

The example shown below declares arelative sort order where or g. acre. I nt er cept or must always be invoked be-
fore org. acne. Aspect . advi ce1() which must be invoked before or g. acne. Aspect . advi ce2() . Here is the JDK
1.5 version:

i mport org.jboss. aop. Precedence;
i mport org.]jboss. aop. PrecedenceAdvi ce;

@°r ecedence
public class M/Precedence

{

@Pr ecedencel nt er cept or
org.acne. I nterceptor intercept;

@°r ecedenceAdvi ce ("advicel")
org. acnme. Aspect precAdvi cel;

@°r ecedenceAdvi ce ("advice2")
org. acme. Aspect precAdvi cez;

And the IDK 1.4 version:

/**
* @@rg. j boss. aop. Precedence
*/
public class M/Precedence
{
/**
* @rg. | boss. aop. Precedencel nt er cept or
*/
org.acne. | nterceptor intercept;
/**
* @rg.jboss. aop. PrecedenceAdvi ce ("advicel")
*/
org. acne. Aspect precAdvi cel;
/**
* @rg. | boss. aop. PrecedenceAdvi ce ("advi ce2")
*/

org. acnme. Aspect precAdvi ce2;
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The ordering of interceptors/advices defined via annotations that have no precedence defined, is arbitrary.

5.13. @DeclareError and @DeclareWarning

Y ou can declare checks to be enforced at instrumentation time. They take a pointcut and a message. If the pointcut
is matched, the message is printed out. To use this with annotations, annotate fields with Decl ar evar ni ng or De-
clareError within a class annotated with @spect oOr @nterceptorDef. The definitions of
org. j boss. aop. Decl areError and or g. j boss. aop. Decl ar eWar ni ng are:

package org.j boss. aop;

@rar get ({ El ement Type. FI ELD}) @Ret enti on( Ret enti onPol i cy. RUNTI ME)
public @nterface Decl areWarni ng

{
String expr();
String nsg();

package org.j boss. aop;

@rar get ({ El ement Type. FI ELD}) @Ret enti on( Ret enti onPol i cy. RUNTI ME)
public @nterface Decl areError

{
String expr();
String msg();

For both: the expr() attribute is a pointcut expression that should not occur, and the msg() attribute is the message
to print out if a match is found for the pointcut. If you use Decl ar eWar ni ng instrumentation/your application will
simply continue having printed the message you supplied. In the case of Decl ar eErr or , the message is logged and
an error isthrown, causing instrumentation/your application to stop. Hereis an examplein JDK 1.5

i mport org.jboss. aop. Aspect;

i mport org.jboss. aop. poi nt cut. Poi nt cut;
i mport org.jboss. aop. Decl areError;

i mport org.jboss. aop. Decl ar eVr ni ng;

@\spect (scope=org.]jboss. aop. advi ce. Scope. PER_VM
public class Decl areAspect

{
@pecl areVar ni ng (expr="cl ass($i nst anceof { Vehi cl eDAC}) AND \
lhas(public void *->save())", \
nmsg="Al | Vehi cl eDAO subcl asses nust override the save() nethod.")
Poi nt cut war ni ng;
@ecl areError (expr="call (* org.acne. busi nessl ayer.*->*(..)) \
AND wi t hi n(org. acne. dat al ayer.*)", \
nmsg="Data | ayer classes should not call up to the business |ayer")
Poi ntcut error;
}
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Andin JDK 1.4:

i mport org.j boss. aop. poi nt cut. Poi nt cut;

/**
* @rg.|jboss. aop. Aspect (scope=org. | boss. aop. advi ce. Scope. PER_VM
*/
public class Decl ar eAspect
{
/**

* @rg. | boss. aop. Decl ar eVar ni ng (expr="cl ass($i nst anceof { Vehi cl eDAC}) AND \
I'has(public void *->save())", \
nmsg="Al | Vehi cl eDAO subcl asses nust override the save() nethod.")

*/

Poi nt cut war ni ng;

/**
* @rg.jboss. aop. Decl areError (expr="call(* org.acne. busi nesslayer.*->*(..)) \
AND wi t hi n(org. acne. datal ayer.*)", \
msg="Data | ayer classes should not call up to the business |ayer")
*
/
Poi ntcut error;
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6.1. Hot Deploment

With JBoss AOP you can change advice and interceptor bindings at runtime. Y ou can unregister existing bindings,
and hot deploy new bindings if the given joinpoints have been instrumented. Hot-deploying within the JBoss ap-
plication server is as easy as putting (or removing) a*-aop. xm file or . aop jar file within the deploy/ directory.
There is adso a runtime APl for adding advice bindings a runtime. Getting an instance of
org. j boss. aop. Aspect Manager . i nst ance() , you can add your binding.

org. j boss. aop. advi ce. Advi ceBi ndi ng bi ndi ng = new Advi ceBi ndi ng("execution(PQIO >new(..))", null);
bi ndi ng. addl nt er cept or ( Si npl el nt erceptor. cl ass);
Aspect Manager . i nst ance() . addBi ndi ng( bi ndi ng) ;

First, you allocated an Advi ceBi ndi ng passing in a pointcut expression. Then you add the interceptor via its class

and then add the binding through the AspectManager. When the binding is added the AspectManager will iterate
through ever loaded classto seeif the pointcut expression matches any of the joinpoints within those classes.

6.2. Per Instance AOP

Any classthat isinstrumented by JBoss AOP, isforced to implement the or g. j boss. aop. Advi sed i nterf ace.

public interface |InstanceAdvised

{
public | nstanceAdvi sor _getlnstanceAdvi sor();
public void _setlnstanceAdvi sor (Il nstanceAdvi sor newAdvi sor);
}
public interface Advised extends |nstanceAdvi sed
{

publ i c Advi sor _get Advisor();
}

The InstanceAdvisor is the interesting interface here. InstanceAdvisor allows you to insert Interceptors at the be-
ginning or the end of the class's advice chain.

public interface |InstanceAdvisor

{
public void insertlnterceptor(lnterceptor interceptor);
public void renmovel nterceptor(String nane);
public voi d appendl nterceptor(lnterceptor interceptor);

public void insertlnterceptorStack(String stackNane);
public void renpvel nterceptorStack(String nane);
public voi d appendl nterceptorStack(String stackNane);
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public Sinpl eMet aDat a get Met aDat a() ;
}
So, there are three advice chains that get executed consecutively in the same java call stack. Those interceptors that
are added with the i nsert I nt er cept or () method for the given object instance are executed first. Next, those ad-
vices/interceptors that were bound using regular bi nds . Finally, those interceptors added with the appendi nt er -

cept or () method to the object instance are executed. Y ou can aso reference st acks and insert/append full stacks
into the pre/post chains.

Besides interceptors, you can also append untyped metadata to the object instance via the getMetaData() method.

6.3. Preparation

Dynamic AOP cannot be used unless the particular joinpoint has been instrumented. Y ou can force intrumentation
with the pr epar e functionality
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7.1. Annotations with JDK 1.4.2

Annotations are only available in JDK 1.5, but using our annotation compiler you can acheive similar functionality
with JDK 1.4.2.

Annotations must map to an annotation type, in JDK 1.5 they are defined as:

package com nypackage;

public @nterface M/Annot ation

{
String nyString();

int nylnteger();
}

Annotation types for use with the annotation compiler are defined in exactly the same way for JDK 1.4.2, with the
important difference that '@interface’ is replaced by 'interface'. i.e. the simulater annotation type is a norma Java
interface:

package com nypackage;

public interface MyAnnotation

{
String nyString();
int nmylnteger();

}

The syntax for using annotations in JDK 1.4.2 is almost exactly the same as JDK 1.5 annotations except for these
subtle differences:

« they are embedded as doclet tags
* Youuseadoubleat sign,i.e.'@@'

* You MUST have a space after the tag name otherwise you will get a compilation error. (This is the quirkiness
of the QDox doclet compiler used to compile the annotations.")

¢ You cannot import the annotation type, you must use the fully qualified name of the interface.

* You cannot specify default values for an annotation's value
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This example shows an annotated classin JDK 1.4.2:

package com nypackage;

/**
* @@om nypackage. M\yAnnot ati on (nyString="class", nylnteger=5)
*/

public class Myd ass

{

/**
* @@om nypackage. M\yAnnot ation (nyString="field", nylnteger=4)
*/

private String nyField;

/**
* @@om nypackage. MyAnnot ati on (nyString="constructor", mnylnteger=3)
*
/
public Myd ass()
{
}
/**
* @@om nypackage. M\yAnnot ati on (nyString="nethod", mnylnteger=3)
*/
public int myMethod()
{
}

7.2. Enums in JDK 1.4.2

Another JDK 1.5 feature that JBoss AOP helps introduce to JBoss 1.4.2 are Enums. As an example we can look at
theorg. j boss. aop. advi ce. Scope enum that is used for the @spect annotation. Hereis the JDK 1.5 version.

package org.j boss. aop. advi ce;

publ i c enum Scope

{
}

PER VM PER CLASS, PER | NSTANCE, PER JO NPOI NT

And it'susagein JDK 1.5

package com nypackage;

@\spect (scope=org.]jboss. aop. advi ce. Scope. PER_VM
public class SoneAspect

{
}

Theusagein JDK 1.4.2 issimilar:

package com nypackage;
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/**
* @rg.jboss. aop. Aspect (scope=org. | boss. aop. advi ce. Scope. PER_VM
e/

public class SoneAspect

{
}

...

However the declaration of the enumeration is different in 1.4.2:

package org.j boss. aop. advi ce;
i mport java.io.Cbject StreanException;

public class Scope extends org.jboss.|ang. Enum

{
private Scope(String nane, int v)
{
super (nane, Vv);
}
public static final Scope PER VM = new Scope("PER VM, 0);
public static final Scope PER _CLASS = new Scope("PER CLASS", 1);
public static final Scope PER | NSTANCE = new Scope("PER | NSTANCE", 2);
public static final Scope PER JO NPO NT = new Scope("PER JO NPO NT", 3);
private static final Scope[] values = {PER VM PER _CLASS, PER_|I NSTANCE, PER_JO NPO NT};
bj ect readResol ve() throws Object StreanException
{
return val ues[ordinal];
}
}

To create your own enum class for use within annotations, you need to inherit from or g. j boss. | ang. Enum Each
enum has two values, a String name, and an integer ordinal. The value used for the ordinal must be the same as it's
index in the static array.

7.3. Using Annotations within Annotations

The annotation compiler allows you to use annotations within annotations. This is best illustrated with an example.
The definitions of the annotation interfacesin JDK 1.4.2:

com nypackage;

public interface Quter

{
}

Inner[] val ues();

com nmypackage;

public interface |nner
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String str();
int integer();

The annotations can be applied as follows

com nypackage;

/**

* @@om nypackage. Quter ({@@om nypackage.|nner (str="x", integer=1), \
@eom nypackage. | nner (str="y", integer=2)})

*/
public class Test
{
I nner[] val ues();
}

7.4. Using the Annotation Compiler

In order to use the JIDK 1.4.2 annotations you have to precompile your files with an annotation compiler.

To use the annotation compiler you can create asimple ant build.xml file

<?xm version="1.0" encodi ng="UTF-8""?>

<proj ect defaul t="run" nane="JBoss/ ACP">
<target nanme="prepare">

Include the jars AOP depends on

<path id="javassist.cl asspath">

<pat hel erent path="../../../javassist.jar"/>
</ pat h>

<path id="trove. cl asspath">

<pat hel enent path="../../../trove.jar"/>

</ pat h>

<path i d="concurrent. cl asspat h">

<pat hel emrent path="../../../concurrent.jar"/>
</ pat h>

<pat h i d="j boss. common. cl asspat h" >
<pat hel enent path="../../../jboss-comon.jar"/>
</ pat h>

<path i d="j boss. aop. cl asspat h">

<pat hel ement path="../../../jboss-aop.jar"/>
</ pat h>

<pat h i d="qdox. cl asspat h" >

<pat hel ement path="../../../qdox.jar"/>
</ pat h>

<path id="cl asspat h">

<path refid="javassist.cl asspath"/>
<path refid="trove.cl asspath"/>

<path refid="jboss. aop. cl asspath"/>
<path refid="jboss.comon. cl asspat h"/>
<path refid="concurrent.cl asspath"/>
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<pat h refid="qdox.cl asspath"/>
</ pat h>

Define the ant task that does the annnotation compilation

<t askdef
nane="annot at i onc"
cl assname="or g. j boss. aop. ant . Annot ati onC"
cl asspat hr ef ="j boss. aop. cl asspat h"
/>
</target>

<target nanme="conpile" depends="prepare">

Compile the sourcefiles

<javac srcdir="."

destdir="."

debug="on"

deprecati on="on"

optimze="of f"

i ncl udes="**">
<cl asspath refid="cl asspath"/>
</javac>

Run the annotation compiler

<annot ati onc conpil ercl asspat href ="cl asspat h" cl asspath="." bytecode="true">
<src path="."/>

</ annot ati onc>

</target>

</ proj ect >

Theorg. j boss. aop. ant . Annot at i onC ant task takes several parameters.

e conpilercl asspath Or conpil ercl asspat href - These are interchangable, and represent the jars needed for
the annotation compiler to work. The conpi | er cl asspat h version takes the paths of the jar files, and the com
pi | ercl asspat href version takes the name of a predefined ant path.

* bytecode - The default is false. If true the annotation compiler instruments (i.e. modifies) the class files with
the annotations. In this case, the classes must be precompiled with javac and cl asspat h Or cl asspat hr ef must
be specified.

e classpath oOr classpathref - Path to the compiled classes to be instrumented with annotations, if
byt ecode="true". The cl asspat h version takes the path of the directory, and the cl asspat href version takes
the name of a predefined ant path.

» xnl - Default isfalse. If true an xml file is generated containing information of how to attach the annotations at

JBoss 1.1 52



Annotation Compiler for DK 1.4

alater stage in the aop process.

e output - If xm ="true", this lets you specify the name you would like for the generated xml file. The default
nameisnet adat a- aop. xm

e verbose - Default isfalse. If true, verbose output is generated, which comes in handy for diagnosing unexpec-
ted results.
Y ou cannot currently specify both byt ecode and xni .

You can also runor g. j boss. aop. ant . Annot at i onC from the command line, you need

$ java -cp <all the JBoss ACP jars and the directory containing files we want to AOP> \
org. j boss. aop. annot ati on. conpi | er. Annot at i onConpi |l er \
[-xm [-0 outputfile ]] [-bytecode]<files>+

In the /bin folder of the distribution we have provided batch/script files to make this easier. It includes all the aop
libs for you, so you just have to worry about your files. The usageis:

$ annot ationc <cl asspath> [-verbose] [-xm [-o0 outputfile]] [-bytecode] <dir_or file>+

e classpat h - path to your classes and any jars your code depends on
The other parameters are the same as above.
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This section defines how to install JBoss AOP standal one, within JBoss 4.0 and within JBoss 3.2.6
(= I jboss-aop_1.0RC2

H | docs
_"l et
I} jboss-32-install

= |} jboss-40-install
[+ [} jboss-aop.deployer
# |7 jboss-aop-jdk50.deployer
i3 lib
) lib-50

3 |3 src

8.1. Installing Standalone

There's nothing really to install if you're running outside the JBoss application server. If you are using JDK 1.4.x,
use the libraries under the 1i b/ directory to build your JBoss AOP applications. If you're using JDK 5.0, use the
libraries under 1 i b- 50/ .

8.2. Installing with JBoss 4.x Application Server

Toinstall BBoss AOP in JBoss 4.x Application Server:

1. Delete j boss- aop. depl oyer file or directory from the existing JBoss Application Server distribution under
server/ <confi g- name>/ depl oy

2. From the JBoss AOP distribution, from the j boss-40-instal | directory copy j boss-aop. depl oyer/ oOr
j boss- aop-j dk50. depl oyer to the JBoss Application Server distribution under server/
<conf i g- nane>/ depl oy depending on which JDK you are running with.

8.3. Installing with JBoss 3.2.6 Application Server

JBoss AOP only works with JBoss Application Server 3.2.6RC1+ and only with the precompiler. Load-time AOP
is not supported at this time for JBoss 3.2.x application server. To install JBoss AOP to JBoss Application Server,
copy al jarsin the j boss-32-instal |/ Or j boss-32-install-jdk5 directory to the server/ <config-nane>/1ib
depending on what version of the JDK you use.
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1. copy al jas in the jboss-32-install/ OF jboss-32-install-jdk5 directory to the server/
<config-nane>/lib
2. Copy et c/ base-aop. xnl to the JBoss Application Server distribution under ser ver/ <conf i g- name>/ depl oy.

3. Edit server/ <confi g- nane>/ conf/j boss-servi ce. xnl to add the appropriate configuration defined in sec-
tion 10.2 "JBoss Application Server”.
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9.1. Instrumentation modes

JBoss AOP works by instrumenting the classes you want to run. This means that modifications to the bytecode are
made in order to add extrainformation to the classes to hook into the AOP library. JBoss AOP allows for two types
of instrumentation

« Precompiled - The classes are instrumented in a separate aop compilation step before they are run.

» Loadtime - The classes are instrumented when they are first |oaded.
This chapter describes the steps you need to take to precompile your classes with the aop precompiler.

9.2. Ant Integration

JBoss AOP comes with an ant task that you can use for precompiling your classes with the aop precompiler. An ex-
ample build.xml file is the basis for the explanation. (It is quite similar to the one used in the previous chapter.)
There will be differencesin the build.xml fileif you are using JDK 1.4.2 or JDK 5.0, these are outlined below:

<?xm version="1.0" encodi ng="UTF-8""?>

<proj ect defaul t="conpile" nane="JBoss/ ACP">
<target nanme="prepare">

Define the source directory, and the directory to compile classes to. If you're not fussy, they can point to the same
directory.

<property name="src.dir" val ue="PATH TO YOUR SOURCE DI R'>
<property nane="cl asses.dir" val ue="PATH TO YOUR DI R FOR COWI LED CLASSES">

Include the jars AOP depends on, these are common to all JDK's

<path id="javassi st.cl asspath">
<pat hel ement path="../../../javassist.jar"/>
</ pat h>

<path id="trove.cl asspat h">
<pat hel enent path="../../../trove.jar"/>
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</ pat h>
<path id="concurrent. cl asspath">

<pat hel ement path="../../../concurrent.jar"/>
</ pat h>
<pat h i d="j boss. conmon. cl asspat h" >

<pat hel ement path="../../../jboss-conmon.jar"/>
</ pat h>

<path id="lib.cl asspath">
<path refid="javassist.classpath"/>
<path refid="trove.cl asspath"/>
<path refid="jboss. aop.cl asspath"/>
<path refid="jboss.comon. cl asspat h"/>
<path refid="concurrent.cl asspath"/>
</ pat h>

This snippet shows what to do for JDK 1.4. It will also work with JDK 5.0 if your classes do not use JDK 5.0 style
annotations and enums:

<l-- JDK version 1.4.2 -->
<lI-- Do not include this if using JDK 1.5 with annotations!!!! -->

<path id="j boss. aop. cl asspat h">
<pat hel ement path="../../../jboss-aop.jar"/>
</ pat h>

<l-- JDK version 1.4.2 - END -->

This snippet shows what to do for JDK 5.0 if you are using JDK 5.0 annotations:

<l-- JDK version 1.5 -->
<lI-- Do not include this if using JDK 1.4.2!!1!! -->

<path i d="j boss. aop. cl asspat h">
<pat hel ement path="../../../jboss-aop-jdkl5.jar"/>
</ pat h>

<l-- JDK version 1.5 - END >

(Y ou should only use one of the two previous snippets for setting up jboss.aop.classpath)

Now we set up the full classpath of all the needed libraries:

<path id="cl asspath">

<path refid="1ib.classpath"/>

<path refid="jboss. aop. cl asspath"/>
</ path id="cl asspat h">

Definetheor g. j boss. aop. ant . AopC ant aop precompiler task:

<t askdef nane="aopc" cl assnane="org.]j boss. aop. ant. AopC"
cl asspat href ="j boss. aop. cl asspat h"/>
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</target>

<target name="conpile" depends="prepare">

Compile the files (from the source directory to the compiled classes directory:

<javac srcdir="${src.dir}"
destdir="%{classes.dir}"
debug="on"
deprecati on="on"
optimze="of f"
i ncl udes="**">

<cl asspath refid="cl asspath"/>
</javac>

Now use the ant aop precompiler task, it reads the files from the

<aopc conpil ercl asspat href ="cl asspat h" verbose="true">
<cl asspath path="${cl asses.dir}"/>
<src path="${cl asses.dir}"/>
<i ncl ude nane="**/* class"/>
<aoppat h pat h="j boss-aop. xm "/ >
<aopcl asspat h pat h="aspects.jar"/>
</ aopc>

If you are using JDK 1.4.2 and wish to use annotations, you need to define the or g. j boss. aop. ant . Annot ati onC
ant task, and run that BEFORE you invoke the or g. j boss. aop. ant . AopC task. How to do thisis shown in the pre-
vious chapter.

Theorg. j boss. aop. ant . AopC ant task takes several parameters.

e conpilercl asspath Or conpil ercl asspat href - These are interchangable, and represent the jars needed for
the aop precompiler to work. The conpi | ercl asspat h version takes the paths of the jar files, and the com
pi | ercl asspat href version takes the name of a predefined ant path. They can be specified as attributes of
aopc, as shown above. conpi | er cl asspat h can also be specified as a child element of aopc, in which case you
can use all the normal ant functionality for paths (e.g. fileset).

e classpath Or cl asspat href - Path to the compiled classes to be instrumented. The cl asspat h version takes the
path of the directory, and the cl asspat href version takes the name of a predefined ant path. They both be spe-
cified as attributes of aopc. cl asspat h can also be specified as a child element of aopc, as shown above, in
which case you can use al the normal ant functionality for paths (e.g. fileset). The full classpath of the underly-
ing java process will be classpath + compilerclasspath.

e src - A directory containing filesto be transformed. Y ou can use multiple src elements to specify more that one
root directory for transformation.

* include - Thisisoptiona and it serves as afilter to pick out which files within sr ¢ should be transformed. Y ou
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can use wildcards within the nane expression, and you can also use multiplei ncl ude elements.

e verbose - Default isfalse. If true, verbose output is generated, which comes in handy for diagnosing unexpec-
ted results.

e report - Default isfalse. If true, the classes are not instrumented, but a report called aop-report . xm is gener-
ated which shows all classes that have been loaded that pertain to AOP, what interceptors and advices that are
attached, and aso what metadata that has been attached. One particularly useful thing is the unbounded section.
It specifys all bindings that are not bound. It allows you to debug when you might have a typo in one of your
XML deployment descriptors.

Report generation works on the instrumented classes, so to get valid data in your report, you have to to make
two passes with aopc. First you run aopc with report="fal se" to instrument the classes, and then you run aopc
withreport ="true" to generate the report.

* aoppat h - The path of the *- aop. xni file containing the xml configuration of your bindings. Files or Director-
ies can be specified. If it is a directory, JBoss AOP will take all aop. xni files from that directory. This gets
used for the j boss. aop. pat h optional system property which is described in the "Command Line" section. If
you have more than one xml file, for example if you have both a "normal" jboss-aop. xn file, and a
net adat a- aop. xni file having used the JDK 1.4.2 annotation compiler, you can specify these as follows:

<aoppat h>

<pat hel enent pat h="j boss-aop. xm "/>
<pat hel enent pat h="net adat a- aop. xm "/ >
<pat hel enent path="xm dir"/>

</ aoppat h>

* aopcl asspat h - This should mirror your class path and contain all JARYdirectories that may have annotated as-
pects (Ses Chapter "Annotated Bindings'). The AOPC compiler will browser each class file in this path to de-
termine if any of them are annotationed with @spect . This gets used for the j boss. aop. cl ass. pat h optional
system property which is described in the "Command Line" section. If you have more than one jar file, you can
specify these as follows:

<aopcl asspat h>

<pat hel ement pat h="aspects.jar"/>
<pat hel enent path="foo.jar"/>

</ aopcl asspat h>

e maxsrc - The ant task expands any directoriesin src to list al class files, when creating the parameters for the
java command that actually performs the compilation. On some operating systems there is a limit to the length
of vaid command lines. The default value for maxsrc is 1000. If the total length of all the files used is greater
than maxsr ¢, a temporary file listing the files to be transformed is used and passed in to the java command in-
stead. If you have problems running the aopc task, try setting this value to a value smaller than 1000.

9.3. Command Line

To run the aop precompiler from the command line you need all the aop jars on your classpath, and the class files
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you are instrumenting must have everything they would need to run in the java classpath, including themselves, or
the precompiler will not be able to run.

Thej boss. aop. pat h optional system property pointsto XML files that contain your pointcut, advice bindings, and
metadata definitions that the precompiler will use to instrument the .class files. The property can have one or files it
points to delimited by the operating systems specific classpath delimiter (*;' on windows, "' on unix). Files or Dir-
ectories can be specified. If it isadirectory, JBoss AOP will take all aop. xni files from that directory.

Thej boss. aop. cl ass. pat h optional system property points to all JARs or directories that may have classes that
are annotated as @spect (See Chapter "Annotated Bindings'). JBoss AOP will browse al classes in this path to
see if they are annotated. The property can have one or files it points to delimited by the operating systems specific
classpath delimiter (';' on windows, "' on unix). Note for this to have effect with JDK 1.4, you first have to run the
annotation compiler with bytecode=true.

Itisinvoked as;

$j ava -classpath ... [-D boss.aop.path=...] [-D boss.aop.class.path=...] \
org. j boss. aop. st andal one. Conpi |l er <class files or directories>

In the /bin folder of the distribution we have provided batch/script files to make this easier. It includes all the aop
libs for you, so you just have to worry about your files. The usage for JDK 1.4 is:

$ aopc <cl asspath> [-aoppath ...] [-aopclasspath ...] [-report] [-verbose] \
<class files or directories>+

And for JIDK 1.5;

$ aopcl5 <cl asspath> [-aoppath ...] [-aopclasspath ...] [-report] [-verbose] \
<class files or directories>+

e classpat h - path to your classes and any jars your code depends on
The other parameters are the same as above.
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Running Aspectized Applications

This section will show you how to run JBoss AOP with standalone applications and how to run it integrated with
the JBoss application server.

10.1. Loadtime vs. Compiletime

There are 2 different modes to run your aspectized applications. Loadtime or precompiled. JBoss AOP needs to
weave your aspects into the classes which they aspectize. You can choose to use JBoss AOP's precompiler to ac-
complish this(Compiletime) or have this weavining happen at runtime when the class is loaded(L oadtime).

Compiletime happens before you run your application. Compiletime weaving is done by using the JBoss AOP pre-
compiler to weave in your aspects to existing .class files. The way it works is that you run the JBoss AOP precom-
piler on a set of .class files and those files will be modified based on what aspects you have defined. Compiletime
weaving isn't always the best choice though. JSPs are a good instance where compiletime weaving may not be feas-
ible.

L oadtime weaving offers the ultimate flexibility, but it requires some tweaking of classloaders that may or may not
be standard depending on which JDK version you use. It is also slower to boot up your aspectized application with
loadtime weavining as the class transformations happen at runtime. Once a class is loaded though, it runs just as
fast as precompiled applications. The way it worksis that when a class needs to be loaded, the AOP runtime library
transforms the bytecode being loaded before the classis loaded by its class loader. To make thiswork with JDK 1.4
requires a little bit of hacking of java.lang.ClassLoader. JDK 5.0 though has a standard way of plugging in a class
transformer viathe java.lang.instrument package.

10.2. Regular Java Applications
JBoss AOP does not require an application server to be used. Applications running JBoss AOP can be run stan-

dalone outside of an application server in any standard Java application. This section focuses on how to run JBoss
AOP applications that don't run in the JBoss application server.

10.2.1. Precompiled instrumentation

Running a precompiled aop application is quite similar to running a normal java application. In addition to the
classpath required for your application you need to specify the files required for aop:

® javassist.jar

* trove.jar
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® concurrent.jar
* jboss-comon.jar
® jboss-aop.jar

® Orjboss-aop-jdk50.jar
- depending on if you are using JDK 1.4 (jboss-aop.jar) or JDK 5.0 (jboss-aop-jdk50.jar)

JBoss AOP finds XML configuration filesin these two ways:

* You tell IBoss AOP where the XML files are. Set thej boss. aop. pat h system property. (Y ou can specify mul-

tiple files or directories separated by ' (*nix) or ;' (Windows), i.e
Dj boss. aop. pat h=j boss- aop. xni ; met adat a- aop. xmi ) If you specify a directory, all aop. xm files will be
loaded from there as well.

e Let JBoss AOP figure out where XML files are. JBoss AOP will look for all XML files that match this pattern
/| META- | NF/ j boss- aop. xni . S0, if you package your jars and put your JBoss AOP XML files within /
META- | NF/ j boss- aop. xni , JBoss AOP will find these files.

If you are using annotated bindings (See Chapter "Annotated Bindings"), you must tell JBoss AOP which JARS or
directories that may have annotated @A spects. To do this you must set the j boss. aop. ¢l ass. pat h system prop-
erty. (You can specify multiple jars or directories separated by ' (*nix) or ;' (Windows), i.e.

Dj boss. aop. cl ass. pat h=aspects.jar; cl asses)

So to run a precompiled AOP application, where your jboss-aop.xml fileis not part of ajar, you enter this at a com-
mand prompt:

$ java -cp=<cl asspath as descri bed above> -D boss. aop. pat h=<path to jboss-aop. xm > \
- Dj boss. aop. cl ass. pat h=aspects.j ar
com bl ah. M\yMai nd ass

To run a precompiled AOP application, where your application contains a jar with a META-INF/jboss-aop.xml
file, you would need to do this from the command-line:

$ java -cp=<cl asspath as descri bed above> com bl ah. M/Mai nd ass

In the /bin folder of the distribution we have provided batch/script files to make this easier. It includes all the aop
libs for you, so you just have to worry about your files. The usage for JDK 1.4 is.

$ run-preconpil ed cl asspath [-aoppath path_to_aop.xm] [-aopclasspath path_to_annotated] \
com bl ah. M\yMai nd ass [args...]

For JIDK 1.5:

$ run-preconpil ed15 cl asspath [-aoppath path_to_aop.xm ] [-aopcl asspath path_to_annotated] \
com bl ah. MyMai nC ass [args...]
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If your application is not in a jar with a META-INF/jboss-aop.xml file, you must specify the path to your
*-aop. xni filesinthe - aoppat h parameter, and if your class comtains aspects configured via annotations ( @spect
efc.) you must pass in this classpath via the - aopcl asspat h parameter. (For JDK 1.4, you must have compiled the
annotationsfirst).

10.2.2. Loadtime

This section describes how to use loadtime instrumentation of classes with aop. The classes themselves are just
compiled using Java, but are not precompiled with the aop precompiler. (If you want to use annotations with JDK
1.4, you will still need to use the JDK 1.4 Annotation Compiler). In the examples given if your classes are con-
tained in ajar with a META-INF/jboss-aop.xml file, you would omit the - Oj boss. aop. pat h System property.

10.2.2.1. Loadtime JDK 1.4

In order to do loadtime weaving of aspects with JDK 1.4, we had to massage j ava. | ang. d assLoader.
java.lang. d assLoader ismodified to add hooks for class transformation before class loading. It isvery similar to
JDK 5's built in ability to define class transformers. What you have to do is generate a modification of
java.lang. d assLoader and add this class to the default bootstrap class path (bootclasspath) for your classes to
get instrumented at |oadtime. The classes used are dependent upon the VM. At present this custom classloader has
only been tested with Sun's J2SE 1.4.x Due to licensing issues we believe we are not allowed to ship the precom-
piled version of the custom classloader. The steps to compile and use the custom classloader are shown below.

USE THISONLY WITH JDK 1.4. See below for how to do loadtime transformations with JDK 5.

$ java -cp=<cl asspath as descri bed above> \
org.j boss. aop. hook. Gener at el nst runent edd assLoader <output dir>

For the following example, the aop boot cl asspat h should be the out put di r specified above, followed by the
jars needed for AOP, i.e. javassist.jar, trove.jar, concurrent.jar, jboss-common. jar and j boss-aop.j ar.
You separate the classpath elements as normal, with *;' (Windows) or "' (Unix). The path to your classes should
NOT be included here! You then use this aop boot cl asspath as the argument for - Xboot cl asspat h option as
shown here:

$ java - Xboot cl asspat h/ p: <aop boot cl asspath as descri bed> \
- Dj boss. aop. pat h=<path to jboss-aop.xn > \
-classpath <path to your classes> com bl ah. MyMai nCl ass

In the /bin folder of the distribution we have provided batch/script files to make this easier. It includes all the aop
libs for you, so you just have to worry about your files:

$ run-1 oad-boot cl asspath [-aoppath path_to_aop.xm ] [-aopclasspath path_to_annotated] \
com bl ah. MyMai nC ass [args...]

The parameters have the same meaning as for the run-precompiled scripts. (Since this is for JDK 1.4, you must
have compiled the annotations first). This script both creates the instrumented class |oader and makes sure that that
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the JAVA_HOME environment variable has been set (Your job isto make sure it pointsto a 1.4 distribution!).

10.2.2.2. Loadtime with JDK 5

JDK 5.0 has a pluggable way of defining a class transformer viathej ava. | ang. i nstrument package. JBoss AOP
uses this mechanism to weave aspects at class load time with JDK 5. Using loadtime with JDK 5 is really easy. All
you have to do is define an additiona standard switch on the Java command line. -javaa-
gent : j boss-aop-j dk50. j ar. For these examples make sure that you use j boss- aop- j dk50. j ar and not j boss-
aop.j ar in your classpath. Here's how run an AOP application in JDK 5.0 with loadtime instrumentation, where
your jboss-aop.xml fileis not part of ajar:

$ java -cp=<cl asspath as descri bed above> -Dj boss. aop. pat h=<path to jboss-aop. xnl > \
-j avaagent : j boss-aop-j dk50. jar com bl ah. MyMai nCl ass

And to run an AOP application in JDK 5.0 with loadtime instrumentation, where your application contains a jar
with a META-INF/jboss-aop.xml file:

$ java -cp=<cl asspath as descri bed above> -j avaagent:j boss-aop-jdk50.jar \
com bl ah. MyMai ndl ass

In the /bin folder of the distribution we have provided batch/script files to make this easier. It includes all the aop
libs for you, so you just have to worry about your files. The usage for JIDK 1.51s:

$ run-1oadl5 cl asspath [-aoppath path_to_aop.xm ] [-aopclasspath path_to_annotated] \
com bl ah. M\yMai nd ass [args...]

The parameters have the same meaning as for the run-precompiled scripts.

If you invoke the previousj ava examples with ant, by using the ant j ava task, make sure that you set f or k="t r ue"
in the ant j ava task. Failure to do so, causes the j ava task to execute in the same VM as ant which is aready run-
ning. This means that the special classloader used to do the loadtime transformations does not replace the standard
one, so no instrumentation takes place.

10.3. JBoss Application Server

JBoss AOP isintegrated with JBoss 4.0 and JBoss 3.2.6RC1+ application server. The integration steps are different
depending on what version of JBoss AS you are using and what JDK version you are using. It is aso dependent on
whether you want to use loadtime or compiletime instrumentation.

The JDK 5.0 integration to do |oadtime transformations is much more stable and reliable than the 4.0 version and it
is highly suggested that you consider moving to both JDK 5 and JBoss AOP's integration with JDK 5 if you want
to do loadtime transformations. JDK 1.4 loadtime works, but it requires custom classloaders and not al libraries
will use the JBoss class loader (i.e. JSPs).

10.3.1. Packaging AOP Applications
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To deploy an AOP application in JBoss you need to package it. AOP is packaged similarly to SARs(MBeans). You
can either deploy an XML file directly in the deploy/ directory with the signature *-aop.xml along with your pack-
age (thisis how the base-aop.xml, included in the j boss- aop. depl oyer file works) or you can include it in the jar
file containing your classes. If you include your xml file in your jar, it must have the file extension .aop and a
jboss-aop.xml file must be contained in a META-INF directory, i.e. META- | NF/ j boss- aop. xm .

If you want to create anything more than a non-trivial example, using the .aop jar files, you can make any top-level
deployment contain a .aop file containing the xml binding configuration. That is you can have a .aop filein an .ear
file, or a .a0p file in a war file etc. The bindings specified in the META- I NF/ j boss-aop. xm file contained in the
.aop file will affect all the classes in the whole war!

10.3.2. JBoss 4.x and JDK 1.4

JBoss AOP comes distributed with the JBoss 4.x Application Server. It is best to download the latest version and
update your JBoss Application Server installation as described in the "Installing” chapter of this guide. Also, the
verson distributed with JBoss 4.x Application Server may not be up to date. Check ht-
tp:/iwww.jboss.org/products/aop to see if a new version of JBoss AOP is available. To install a new version re-
move the jboss-aop.deployer file from the JBoss AS deploy/ directory and copy the jboss-aop.deployer directory
from the JBoss AOP distribution to the JBoss AS deploy/ directory. This jboss-aop.deployer/ is in the JBoss AOP
distribution within the jboss-40-install/ directory.

JBoss 4.x Application Server works out of the box with precompiled applications. If you want to do load-time
transformations, you must edit jboss-aop.deployer/META-INF/jboss-service.xml as follows:

Thej boss- aop. depl oyer file contains some MBeans that deploy and manage the AOP framework.

<nbean code="org.jboss. aop. depl oynent . Aspect Manager Ser vi ce"
nanme="j boss. aop: servi ce=Aspect Manager " >
<attribute name="Enabl eTransformer">fal se</attri bute>

<l-- only relevant when Enabl eTransforner is true -->
<attribute name="SuppressTransformati onErrors">true</attri bute>
<l-- only relevant when Enabl etransfornmer is true. Optimzation is optiona

only just in case there is a bug init -->

<attribute name="Qptim zed">true</attribute>

<attri bute name="Verbose">fal se</attribute>
</ nbean>

<nbean code="org.j boss. aop. depl oynent . Aspect Depl oyer"
nanme="j boss. aop: servi ce=Aspect Depl oyer " >
</ mbean>

By default, JBoss application server will not do load-time bytecode manipulation of AOP files. Y ou can turn load-
time on by setting the EnableTransformer attribute to true. If SuppressTransformationErrors is true failed bytecode
transformation will only give an error warning. This flag is needed because the JSP compiler does not run within a
JBoss classloader and the AOP |loader cannot resolve classes from this JSP classloader.

10.3.3. JBoss 4.x and JDK 5

The JDK 5.0 integration to do |oadtime transformations is much more stable and reliable than the 4.0 version and it
is highly suggested that you consider moving to both JDK 5 and JBoss AOP's integration with JDK 5 if you want
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to do loadtime transformations. JDK 1.4 loadtime works, but it requires custom classloaders and not al libraries
will use the JBoss class loader (i.e. JSPs).

JBoss AOP comes distributed with the JBoss 4.x Application Server. The version that comes with JBoss 4.x does
not take advantage of JDK 5.0 features. It is best to install the jboss-aop-jdk50.deployer/ distribution into your
JBoss Application Server install base. See the "Installing” chapter for more details.

If you want to do load-time transformations with JBoss 4 and JDK 5, there are two steps you must take.

Thej boss- aop-j dk50. depl oyer file contains some MBeans that deploy and manage the AOP framework.

<nbean code="org.jboss. aop. depl oynent . Aspect Manager Ser vi ceJDK5"
nanme="j boss. aop: servi ce=Aspect Manager " >
<attri bute name="Enabl eTr ansf orner" >f al se</attri bute>

<I-- only rel evant when Enabl eTransforner is true -->
<attribute name="SuppressTransformati onErrors">true</attri bute>
<I-- only relevant when Enabl etransformer is true. Optimzation is optional

only just in case there is a bug init -->

<attribute name="QOpti m zed">true</attribute>

<attribute name="Verbose">fal se</attribute>
</ mbean>

<nbean code="org.j boss. aop. depl oynent . Aspect Depl oyer"
nane="j boss. aop: servi ce=Aspect Depl oyer" >
</ nbean>

By default, JBoss application server will not do load-time bytecode manipulation of AOP files. Y ou can turn load-
time on by setting the EnableTransformer attribute to true. If SuppressTransformationErrors is true failed bytecode
transformation will only give an error warning. This flag is needed because the JSP compiler does not run within a
JBoss class oader and the AOP loader cannot resolve classes from this JSP classloader.

The next step isto copy the pluggable-instrumentor.jar from the lib-50 directory of your JBoss AOP distribution to
the bin/ directory of your JBoss AOP application server installation. Next edit run.sh or run.bat (depending on what
OSyou're on) and add the following to the JAVA_OPTS environment variable

set JAVA OPTS=%AVA OPTS% - Dpr ogr am nane=%°ROGNAVE% - j avaagent : pl uggabl e-i nstrunentor.j ar

After modifying JAVA_OPTS and setting the EnableTransformations to true, then you should be ready to go.

10.3.4. JBoss Application Server 3.2.x and JDK 1.4

JBoss AOP can also work with JBoss 3.2.7 (maybe 3.2.6) and higher in the JBoss 3.2 series. Look in the Installing
chapter on how to install the JAR files.

After installing, you need to modify the j boss- 3. 2. 7/ server/ xxx/ conf/j boss-service. xnl file to add these
mbean definitions. They are similar to the 4.0 release, but notice the '32' added to the class name.

<nbean code="org.j boss. aop. depl oynent . Aspect Manager Ser vi ce32"
nanme="j boss. aop: servi ce=Aspect Manager " >
<attri bute name="Enabl eTr ansf orner">f al se</attri bute>
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<I-- only rel evant when Enabl eTransforner is true -->
<attribute name="SuppressTransformati onErrors">true</attri bute>
<I-- only rel evant when Enabl etransforner is true. Optimzation is optiona

only just in case there is a bug init -->

<attribute name="Optim zed">true</attri bute>

<attribute name="Verbose">fal se</attribute>
</ nbean>

<nbean code="org. | boss. aop. depl oynent . Aspect Depl oyer 32"

nanme="j boss. aop: servi ce=Aspect Depl oyer " >
</ nbean>

Also, copy the base- aop. xn fileinto the server/xxx/deploy/ directory if you want to use any of JBoss Aspects.

10.1. JBoss 3.2.x and JDK 5

The JDK 5.0 integration to do loadtime transformations is much more stable and reliable than the JDK 1.4 integra-
tion it is highly suggested that you consider moving to both JDK 5 and JBoss AOP's integration with JDK 5 if you
want to do loadtime transformations. JDK 1.4 loadtime works, but it requires custom classl oaders and not all librar-
ieswill use the JBoss class |oader (i.e. JSPs).

To use JDK 5 loadtime with JBoss 3.2.x make sure you follow the directionsin the 'Installing' chapter.
If you want to do load-time transformations with JBoss 3.2.7 and JDK 5, there are two steps you must take.
After installing, you need to modify the j boss-3. 2. 7/ server/ xxx/ conf/j boss-servi ce. xn file to add these

mbean definitions. They are similar to the 4.0 release, but notice the ‘32" added to the class name.

<nbean code="org.jboss. aop. depl oynent . Aspect Manager Ser vi ce32JDK5"
nane="j boss. aop: servi ce=Aspect Manager " >
<attri bute name="Enabl eTr ansf or ner">f al se</attri bute>

<l-- only relevant when Enabl eTransforner is true -->
<attribute name="SuppressTransformati onErrors">true</attri bute>
<l-- only relevant when Enabl etransfornmer is true. Optimzation is optiona

only just in case there is a bug init -->

<attribute name="Qptim zed">true</attribute>

<attribute name="Verbose">fal se</attribute>
</ mbean>

<nbean code="org.j boss. aop. depl oynent . Aspect Depl oyer 32"
nanme="j boss. aop: servi ce=Aspect Depl oyer" >
</ mbean>

Also, copy the base- aop. xn fileinto the server/xxx/deploy/ directory if you want to use any of JBoss Aspects.

By default, JBoss application server will not do load-time bytecode manipulation of AOP files. Y ou can turn load-
time on by setting the EnableTransformer attribute to true. If SuppressTransformationErrors is true failed bytecode
transformation will only give an error warning. This flag is needed because the JSP compiler does not run within a
JBoss classloader and the AOP loader cannot resolve classes from this JSP classloader.

The next step is to copy the pluggable-instrumentor.jar from the lib-50 directory of your JBoss AOP distribution to
the bin/ directory of your JBoss AOP application server installation. Next edit run.sh or run.bat (depending on what
OSyou're on) and add the following to the JAVA_OPTS environment variable
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set JAVA OPTS=%AVA OPTS% - Dpr ogr am name=%ROGNAME% - j avaagent : pl uggabl e-i nstrunentor. j ar

After modifying JAVA_OPTS and setting the EnableTransformations to true, then you should be ready to go.
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Reflection and AOP

While AOP works fine for normal access to fields, methods and constructors, there are some problems with using
the Reflection API for this using JBoss. The problems are:

¢ Intereptors/aspects bound to exexcution pointcuts for fields and constructors don't get invoked.
* Intereptors/aspects bound to caller pointcuts for methods and constructors don't get invoked.

» Reflection Methods such as d ass. get Met hods() and d ass. get Fi el d() return extra JBoss AOP "plumbing"
information.

11.1. Force interception via reflection

To address the issues with interceptors not being invoked when you use reflection, we have provided a reflection
aspect. You bind it to a set of caller pointcuts, and it mounts the pre-defined interceptor/aspect chains. The jboss-
aop.xml entries are:

<aspect cl ass="org.|boss. aop.reflection.ReflectionAspect" scope="PER VM'/>

<bi nd poi ntcut="call (* java.lang. d ass->new nstance())">
<advi ce nanme="i nt er cept New nst ance" \
aspect ="org. j boss. aop. refl ecti on. Refl ecti onAspect"/ >
</ bi nd>

<bi nd pointcut="call (* java.lang.refl ect.Constructor->new nstance(java.lang. Qvject[]))">
<advi ce nane="i nt er cept Newl nst ance" \
aspect ="org. j boss. aop. refl ection. Refl ecti onAspect"/>
</ bi nd>

<bi nd pointcut="call (* java.lang.reflect.Method->i nvoke(java.lang. Object, java.lang. Object[]))">
<advi ce name="i nt er cept Met hodl nvoke" \
aspect ="org. j boss. aop. refl ection. Refl ecti onAspect"/ >
</ bi nd>

<bi nd poi ntcut="call (* java.lang.reflect.Field->get*(..))">
<advi ce nanme="interceptFieldGet" \
aspect ="org. j boss. aop.refl ecti on. Refl ecti onAspect"/>
</ bi nd>

<bi nd pointcut="call (* java.lang.reflect.Field->set*(..))">
<advi ce name="interceptFiel dSet" \
aspect ="org. j boss. aop. refl ection. Refl ecti onAspect"/>
</ bi nd>
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The Refl ecti onAspect class provides a few hooks for you to override from a subclass if you like. These methods
described below.

protected Obj ect interceptConstructor(
I nvocati on i nvocati on,
Constructor constructor,
bj ect[] args)
throws Throwabl e;

Cdlls to d ass. newi nstance() and Constructor. newi nstance() end up here. The default behavior is to mount
any constructor execution or caller interceptor chains. If you want to override the behaviour, the parameters are:

e invocation - Theinvocation driving the chain of advices.

e constructor - Theconstructor being called

e args - the arguments being passed in to the constructor (in the case of Class.newlnstance(), a zero-length array
since it takes no parameters)

protected Object interceptFiel dRead(
| nvocati on i nvocati on,
Field field,
bj ect instance)
t hrows Throwabl e;

Cdlls to Fi el d. get Xxx() end up here. The default behavior is to mount any field read interceptor chains. If you
want to override the behaviour, the parameters are:

e invocation - Theinvocation driving the chain of advices.
e field-Thefield being read

* instance - Theinstance from which we are reading a non-static field.

protected bject interceptFiel dWite(
I nvocation invocati on,

Field field,
Cbj ect instance,
bj ect arg)

t hrows Thr owabl e;

Cdllsto Fi el d. set xxX() end up here. The default behavior is to mount any field write interceptor chains. If you
want to override the behaviour, the parameters are:

e invocation - Theinvocation driving the chain of advices.

JBoss 1.1 70



Reflection and AOP

e field- Thefield being written
e instance - Theinstance on which we are writing a non-static field.

e arg - Thevauewe are setting the field to

protected Object interceptMethod(
I nvocation invocation,
Met hod net hod,
Cbj ect instance,
oj ect[] args)
throws Throwabl e;

Calls to Met hod. i nvoke() end up here. The default behavior is to mount any method caler interceptor chains
(method execution chains are handled correctly by default). If you want to override the behaviour, the parameters
are:

* invocation - Theinvocation driving the chain of advices.
* et hod - The method being invoked
* instance - Theinstance on which we are invoking a non-static method.

e args - Valuesfor the method arguments.

11.2. Clean results from reflection info methods

The Ref I ect i onAspect also helps with getting rid of the JBoss AOP "plumbing” information. You bind it to a set
of caller pointcuts, using the followingjboss-aop.xml entries :

<bi nd pointcut="call (* java.lang.d ass->getlnterfaces())">
<advi ce nane="interceptGetlnterfaces" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd poi ntcut="call (* java.l ang. d ass->get Decl ar edMet hods()) ">
<advi ce name="i nt er cept Get Decl ar edMet hods" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd pointcut="call (* java.lang. d ass->get Decl aredMet hod(..))">
<advi ce nanme="i nt er cept Get Decl ar edMet hod" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd pointcut="call (* java.lang. C ass->get Met hods())">
<advi ce nane="int er cept Get Met hods" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd poi ntcut="call (* java.lang.d ass->get Method(..))">
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<advi ce nane="i nt er cept Get Met hod" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd pointcut="call (* java.lang. Cl ass->get Decl aredFi el ds())">
<advi ce name="i nt er cept Get Decl ar edFi el ds" \
aspect="org.j boss.test.aop.refl ecti on. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd pointcut="call (* java.lang. d ass->get Decl aredC asses())">
<advi ce nanme="i nt er cept Get Decl ar edCl asses" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

<bi nd poi ntcut="call (* java.lang.d ass->getDeclaredField(..))">
<advi ce name="int er cept Get Decl ar edFi el d" \
aspect="org.j boss.test.aop.refl ection. Refl ecti onAspect Tester"/>
</ bi nd>

Thisway the callsto d ass. get Met hods() etc. only return information that is present in the "raw" class, by filter-
ing out the stuff added to the class by JBoss AOP.
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JBoss AOP IDE

12.1. The AOP IDE

JBoss AOP comes with an Eclipse plugin that helps you define interceptors to an eclipse project viaa GUI, and to
run the appication from within Eclipse. Thisis a new project, and expect the feature set to grow quickly!

12.2. Installing

You install the BBoss AOP IDE in the same way as any other Eclipse plugin.

* Make sure you have Eclipse 3.0.x installed, and start it up.

e Select Help > Software Updates > Find and Install in the Eclipse workbench.

* Inthewizard that opens, click on the "Search for new featuresto install" radio button, and click Next.

*  Onthe next page you will need to add a new update site for JBossIDE. Click the "New Remote Site.." button.

« Typein "JBossIDE" for the name, and "http://jboss.sourceforge.net/jbosside/updates” for the URL, and click
OK.

e You should see a new sitein the list now called JBossIDE. click the "+" sign next to it to show the platforms
available.

* Now, depending if you just want to install the AOP IDE (if you don't know what JBoss-IDE is, go for this set of
options):
* Check the "JBoss-IDE AOP Standalone" checkbox.

* Inthefeaturelist you should check the "JBoss-IDE AOP Standalone 1.0" checkbox.

If you have JBoss-IDE installed, or want to use all the other (non-AOP) features of JBoss-IDE:

e |f you don't have JBossIDE installed, check the "JBoss-IDE 1.4/Eclipse 3.0" checkbox.
* Check the"JBoss-IDE AOP Extension" checkbox.

e In the feature list you should check the "JBoss-IDE AOP Extension 1.0" checkbox, and the JBoss-IDE
(1.4.0) checkbox if you don't have JBossIDE installed.
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e At this point you should only need to accept the license agreement(s) and wait for the install processto finish.

12.3. Tutorial

This tutorial is meant to guide you through creating a new AOP project in eclipse using the AOP extension to
JBossIDE. It assumes that you have some working knowledge of AOP, and Java.. and possibly some minimal ex-
perience dealing with eclipse as well.

12.3.1. Create Project

e From eclipse's main menu, you can click on the File Menu, and under it, New > Project...
» Doubleclick on JBoss AOP Project under the JBossAOP folder
* Inthe Project Name text box, let's enter Hel | oACP.

e Use Default should be fine for the project location. (If you want to use an external location, make sure there
are no spaces in the path.)

¢ Click Fini sh

At this point, your eclipse workbench should look something like this:
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12.3.2. Create Class

Next step isto create anormal Java class.

* Right click on the "src" directory in the Package Explorer and in the menu, click New > Class.

* The only thing you should need to change is the Name of the class. Enter Hel | oAOP without quotes into the

Name textbox, and click Fi ni sh

Modify the code for your class so it loks like

public class Hell oACP {

public void call M ()

{
System out. println("AOP!");
}
public static void main (String args[])
{

new Hel | oACP() . cal | Me();
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12.3.3. Create Interceptor

Next we want to create an interceptor to the class.

» Right click on the "src" directory in the Package Explorer and in the menu, click New > Class. In the resulting
dialog:

* Namethe classHel | 0ACPI nt er cept or

e Addorg.jboss. aop. advi ce. I nt ercept or to thelist of interceptors.
Then modify the class so it looks like:

i mport org.jboss. aop. advi ce. I nterceptor;
i mport org.jboss. aop.joi npoint.I|nvocati on;

public class Hel | oACPI nterceptor inplements Interceptor {

public String getName() ({
return "Hel | oACOPI nterceptor”;

}

/W& renanmed the argO parameter to invocation
publ i c Qoject invoke(lnvocation invocation) throws Throwabl e {
Systemout.print("Hello, ");
//Here we invoke the next in the chain
return invocation.invokeNext();

}

12.3.4. Applying the Interceptor

In order to apply your Interceptor to the callMe() method, we'll first need to switch back to the Hel | oACP. j ava edit-
or. Once the editor is active, you should be able to see the callMe() method in the Outline view (If you cannot see
the outline view, go to Window > Show View > Ouitline).

E= outline 53 = |m
1L 8w @ W -

o (9, HelloACP
— - @ callMel)
@5 main{String[])
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Right click on this method, and click JBoss AOP > Apply Interceptor(s)... A dialog should open, with a list of
available Interceptors. Click on Hel | 0ACPI nt er cept or , and click Fi ni sh.

Y ou should see in your Package Explorer that the file "jboss-aop.xml" now exists under your project root.

12.3.5. Running

Now all that's Ieft is running the application! Similar to running a normal Java Application from Eclipse, you must
create a Run Configuration for your project.

e From the Run menu of eclipse, and choose "Run..."

» Inthedialog that opens, you should see afew choicesin alist on the left. Double click on "JBoss AOP Applic-
ation".

* Once it is finished loading, you should have a new Run Configuration under JBoss AOP Application called
"Hello AOP".

* Click the"Run" button
The Eclipse console should now say: Hel | o, ACP!, wherethe Hel | o, bit has been added by the interceptor.

Problems | Javadoc | Dedaration ECDHSDIE o

<terminated > HellbAOP [JBoss AQP Application] C:\devtoolsijdk 1. 44binYj
Hello, AOQP

12.3.6. Navigation

In the real world, when developing AOP application across a development team, you can expect it will be hard to
understand when and where aspects are applied in your codebase. JBoss-IDE/AOP has afew different strategies for
notifying devel opers when an aspect is applied to a certain part of code.

12.3.6.1. Advised Markers

A marker in eclipse is a small icon that appears on the left side of the editor. Most developers are familiar with the
Java Error and Bookmark markers. The AOP IDE provides markers for methods and fields which are intercepted.
To further facilitate this marking, anytime the developer presses Ctrl + 1 (the default key combination for the Ec-
lipse Quick Fix functionality)), alist of interceptors and advice will be given for that method or field. This makes
navigation between methods and their interceptors extremeley easy!
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HelloACP.java &2 [J] HelloInterceptor.java B
-y
* Created on Oct 20, 2004
L | = To change the template for this generated file go to
* Window - Preferences - Java - Code Style - Code Templates
- £
Marshall

To change the template for this generated type comment go to
“Window - Preferences - Java - Code Style - Code Templates

vpﬁhlic class HelloAOP {

Sk
Itad
TR TR T R TR TR

%5 =  public void callMe ()
1
¥ %9 Go to Interceptor 'HelloInterceptor’ (execute) 50 to Interceptor ‘HelloInterceptor’ (execute)

v P

¥
¥

12.3.6.2. The Advised Members View

The Advised Members view gives the developer an overview of every single method and field in the current class
that is advised by an Aspect or Interceptor. Let's have alook.

e From the Eclipse main menu, click on Window > Show View > Other...

« Inthewindow that opens, you should see afolder called "JBoss AOP". Pressthe "+" to expand it.

* Doubleclick on "Advised Members'

Once you've done this, you should now make sure you are currently editing the Hel | oACOP class we created in the
last tutorial. Once you have that class open in an editor, you should see something similar to this in the Advised
Members view:

@. Advised Members &7 =0

= @ calMe()
%3 HelloInterceptor

Here we see that the method "callMe()" is intercepted by the interceptor Hel | ol nt er cept or . Double clicking on
Hel | ol nt er cept or Will take you straight to it. This view is similar to the Outline view, except it only shows mem-
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bersin your class which are intercepted.

12.3.6.3. The Aspect Manager View

The Aspect Manager View isagraphical representation of the AOP descriptor file (jboss-aop.xml). It allows you to
remove an Interceptor or advice from a pointcut, as well as apply new Interceptors and Advice to existing
pointcuts.

* From the Eclipse main menu, click on Window > Show View > Other...
* Inthewindow that opens, you should see afolder called "JBoss AOP". Press the "+" to expand it.
« Doubleclick on "Aspect Manager"

Under Bindings, you'll notice that a pointcut is aready defined that matches our "callMe()" method, and our Hel -
| ol nt er cept or isdirectly under it. Right Click on Hel | ol nt er cept or will provide you with this menu:

Problems | Javadoc | Dedaration E,L.ﬁ.specthﬂanager £

= =%= Bindings
—I-=§= execution{public void HellbAQP-=calMe(})

%5 HelloInterceptor i
> GoTo

¥ Remove

You can remove the interceptor, or jump to it directly in code. If you right click on the binding (pointcut) itself,
you'll be able to apply more interceptors and advice just like when right clicking on afield or method in the outline
view. You can also remove the entire binding altogether (which subsequently removes all child interceptors and ad-
vice, be warned)

Problems | Javadoc | Dedaration | %, Aspect Manager -

= =%= Bindings
- =%- execution{public void HelloAOP-=calMe ()}
%9 HelloInterceptor %3 Apply Interceptor(s)...

%5 Apply Advice...

¥ Remove
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